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« The (Not So) Short Introduction to EIEX2e ' (¥ =2t stzof Hiojo| EXBHCL
FETEX 26 22J. TeX Live2F MiKTeXOfl
e Learn LaTeX in 30 minutes TS| QOB 2 texdoc lshort-ko
s - THS U2|H iz 92 & AT
« https://en.wikibooks.org/wiki/LaTeX/

A 281 o] - 25te] 22 A SHe BIpX ] WAl Sob Aot

11 b A4

A Z2AA 7159 4 FE2 olHEE sid 4 oy, 223 R = KX H9
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gtth= Zojt. mf7] 2o tisiAl= 1.1.38 04 BEdrg3ct

7] 22} 18] X o Xh*%% Comprehensive TeX Archive Network (CTAN)
olghe UER FoA A& 4 At ¥ F4E https://www. ctan.orgo|t}.

o] ¥ CTAN:o|2t1l ®7|5t A2 ﬁiﬁP% CTAN f]2]9] TgX g2t 9n=
AF2-517Th, oA CTAN://latex4wpehal E@SH 212 https://mirror.ctan.org/
pkg/latex4wpol sligetet.
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« TeXstudio (HE]Z3E; GNU/Linux Applmage 2} Windows-§ portable app ©]-&
7}s): https://www.texstudio.org



https://www.ctan.org/tex-archive/info/lshort/
https://github.com/KoreanTUG/lshort-ko
https://www.overleaf.com/learn/latex/Learn_LaTeX_in_30_minutes
https://en.wikibooks.org/wiki/LaTeX/
https://www.ctan.org
https://www.ctan.org
https://mirror.ctan.org/pkg/latex4wp
https://mirror.ctan.org/pkg/latex4wp
https://mirror.ctan.org/pkg/latex4wp
https://www.texstudio.org

« TeXworks (BE] 221 ; GNU/Linux Applmage -5):
https://tug.org/texworks/ (TeX Live©l Z3g})
+ Texmaker (HE]Z2HE): https://www.xmlmath.net/texmaker/index.html
« TeXShop (Mac OS X): https://www.uoregon.edu/koch/texshop/
« TeXnicCenter (Windows):
https://www.texniccenter.org/
a3 A A BIEX 2-8= dAttth S8 &2 pdflatex = xelatex, lualatex 2=
AJJ5h= PDFolt}. o7k 2 e x3hs}7) = tf o)A PostscripTU EPSE 113514
%e=tt

rlr

1.1.1 °j|A] Ko]7|o| Bs}o]

o] A A= 53]—01 CTAN://latexdemo TH7| X7} A&k B BIpX Z&= 2243 1 &
S Hol= 752 &85t olubZ latexdemo7}t 2 F2&61A] S ulf of 7 CTAN:/

example T7| A & |27} 2 F $4 5o} E-ggF Ho] Qlct. S ot =of wo =oj| A= 222 ol
20|72 WZX| 1 (tcolorboxS
0|83Hs) Ero| 22 KHABto]

112 9HE7} A Lst= 75 LESALL.

BIpX-2 237]|Y ®olot. AA0] Zehy7] £o]7], 27] "upt7] 52 ot g7} 3H$°1°F
stoh E 12 HFEH H27HE AlololA §38 ¢t ol B GNU emacs, vimt jed 9]
£ Q9K Zlojt}, jed= EMEIDE 7] HiQIG o2 A3kt

1.1.3 7| A] F7}517]

olzf] AL tjEE o] GNU/Linuxoll L% 0] Y= TeX A ARl TeX Liveol A-&Hch,
MacTeXo A= §&35 Zo|xgt WAt Linuxol © <3ttt 714 833 Windows
i 2239l MiKTeX2 913t 2132 w2 Aol =7t
o9 -2 BIpX 7] A7} 7| 24 0 2 Alg-Hrt. olE £ dv|Qt 7|¥ke] GNU/Linux
HHsTai%% texlive-* E}i ol &9 W mi7| A& ZEFIL ITh( 7|4 w7 A2k o A2
ot A 0 2 KIEX 7| 2|9t 25514 FEE gt
o7k thd thg AAE w2et,

l:o

$ mkdir -p ~/texmf/tex/latex

o] Tielele] ofeh A} W] 2| & Mg,

2. 71718 CTAN v 22 € 117]2] & the2 =5t} thAl 2 zip o 2 ¢&H HE 2
2 Zojt}t, o] A4S foo.zipolet 27| 2 1A}

3. A% A1x00] &S Eeh,

$ mkdir ~/texmf/tex/latex/foo
$ mv foo.zip ~/texmf/tex/latex/foo

$ cd ~/texmf/tex/latex/foo ; unzip foo.zip



https://tug.org/texworks/
https://www.xm1math.net/texmaker/index.html
https://www.uoregon.edu/koch/texshop/
https://www.texniccenter.org/
https://mirror.ctan.org/pkg/latexdemo
https://mirror.ctan.org/pkg/example
https://mirror.ctan.org/pkg/example
https://mirror.tug.org/texlive
https://mirror.tug.org/mactex/
https://miktex.org

A Emacs Vim Jed
3 me Alt-X ESC Alt-X
A rE n/a iao0 n/a
i R n/a : n/a
el =3}
o 7] Ctrl-X Ctrl- e Ctrl-KE
o Al Ctri-Xi r Ctrl-KR
ol A% Ctrl-X Ctrl-S W Ctrl-KD
Molgoz Ctrl-X Ctrl-W name W name Ctrl-KS
ol 271 Ctrl-XK :q Ctrl-KQ
H 3 H7 Ctrl-XB bN Ctrl-KN
%] 4 (undo) Ctri-xu u Ctrl-u
AL (redo) ctri-" Ctrl-R Ctrl-G Ctrl-U
E47] Ctrl-X Ctrl-C :qa! Ctrl-KXx
A o] &
St thof 21 Alt-B b Ctrl-A
Stdo] o2& Alt-F W Ctrl-F
PxgoZ Ctrl-A 0 Ctrl-Qs
ooz Ctrl-E $ Ctrl-QD
ShHo]x] o2 Alt-V Ctrl-u Ctrl-R
StEo|x] HE Ctrl-v Ctrl-D Ctrl-C
H 3 o] TS Alt-< 1G Ctrl-QrR
H 1 o] ghE Alt-> G Ctrl-QC
A A5k oz Alt-G n. n.G Ctr1-qQI
AEAjI517]
AZ 3+ FA¢ Ctrl-H X BS
REZ I ZA} Ctrl-D X Alt-G
YZ sk ol Alt-DEL db Alt-BS
LEZ 5l tho] Alt-D dw Ctrl-T
ZE7HA| Ctrl-K ds$ Ctrl-QY
Az Ctrl-A Ctrl-K dd Ctri-Y
7] & HFE]
27 Ctrl-S text /text Ctrl-Qs
Zrolu}at 7] Alt-% :s/old/new/g Ctrl-QA
HEF Y
Ael A2k Ctrl-SPACE v Ctrl-KB
Zretu 7] Ctri-w D Ctrl-KY
HAFsH| Alt-w Y Ctrl-KH
2o497] ctrl-Y P Ctrl-KC
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4. THoF sty ok o] EZx5}A] k=t latex foo.ins® latex foo.dtx HHS
AgYsto] 17 Zojujoof gt
5. O W3 e Aegsict.

$ texhash ~/texmf

MiKTEX A 37] 2] & 27152 ¥ * MiKTEX console o] B &3-S o] &5t}

\latex\newpackage H&E| 2] 5 C:\localtexmf\tex\ of2foll T3 B % o}
22 of7|o| 7}11:} o}, Yol A3t xS w2 thg MiKTeX Options S Agsto] =
‘Refresh now’ HHES FE2TF = initexmf -u FHS HFFolA A3Pstct, o] Zl o]

0l

A,

ot 1} 7] 2] 7} A 2] E S0l = \documentclass A o]Sof o} S 50 24 24l
o] 2Ajol 28T 4 AUtk
\usepackage{foo}

1.1.4 Info Ho|A] 37}
‘man’#} ‘info’ #|0] A= AT ESfoje] Ar FAE HH Y
UnixU GNU/Linux A|ABlol|A] £5] AL&-&]= Zlo|tt. ®
2| =]of Qx| eko v thew} 2ol Blat.
1 oS oz ERt
https://tug.ctan.org/info/latex2e-help-texinfo/latex2e.info;

2l MIOIAE A &5t= iﬁi
latex2e.info

$ gzip latex2e.info

$ sudo cp latex2e.info.gz /usr/share/info/

$ sudo ginstall-info latex2e.info dir

ol info latex2e WO = info ZAE S 5

12 24 Aol $38
FolEG o= *]"_%]'% g i of ghct.
e —E—/ﬂ% H (part) - %} (chapter) -

£ 7} ohjete

Zole}. Zpalo] o} 721 & of of 7|31
0] 24 07| Zo] that vhgol

e =2 W27 ENAE

(53547 2| Unix TeX Live Al AE10f|A
~/texmf = TEXMFHOMEO|2t= A 2=0f|
stete|of QUCt. w2t HE 2 texhashlt
mktexlsrg *e"’oHOf | QO EICH AJAE
2| X2 M TEXMFLOCAL (%[0 22
IH7 | XS X[ E mof= o] FHE | MHO|
ZQstCt.

o] 2Etojl M MEBHE MiKTEX 4
H*EQ Z= Ol HH 2 flet Aolch 2023E|

E
C: \localtexmf t 7|25
UX| Q410 AFS K A
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o] ml¥rol Lot FE LRE BEXI FAstth & EW Filel>Open(wHed 471)

File ¥+

File[>Save(*7%5}7]), File[>Close(27]) &2 ol|t]E]9] 7|5o|t}.

2.1 File>New (A }+¥)

CEEE

mjo]7) st} phE s FE s ohe 3 2,

9= mR Aol A o] w42 Mt ¥l Bl x| shutE HolETh, KXo 2 ¥l

\documentclass{article}
\thispagestyle{empty} % Lf|O|Z| HHS A|A

\begin{document}
% 0| HE2 =AM (comment). 27} MELCt.
\end{document}

BRX o2 443 BAL RAdor 32 o)ty 23 o A2 oAl g ¥

\documentclass[adpaper,12pt]{article}
\begin{document}

\title{My Document}

\author{John Smith}

\date{London, \today}

\maketitle

\begin{abstract}

This is a very short article.

\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\section{First Section}

\label{sec:start}

This is the text of the section. See \cite{Gonzato} for details.
\section{End}

\label{sec:end}

This is the end of the document. Please go to Section
\ref{sec:start} to read it again.
\begin{thebibliography}{99}

\bibitem{Gonzato} Gonzato G. \textit{\LaTeX{} for Word Processor
Users}. CTAN, 2001--2023.

\end{thebibliography}

\end{document}

20| Aol o B 4 Eglo] nlaiEo] i},

2.2 File[>Save As...(t}2 g2 0 2 #7F})

BEX £48 o2 000 2 Wel A 8 o) A8 4 9l RSl

« TEX4ht+= BIEX-S HTML/XMLZ ¥135}7] Qe 2] =2 38 Zolct, °
https://tug.org/tex4ht

[
Al
=

HFTeX Liveofl el Iwarp2hs TH7| X &

HE 2 I}

FILE 0|5+


https://tug.org/tex4ht

« HTMLZ ¥&s}17] 93l latex2htmlS o] 88 % t},
CTAN://latex2html

« latex2rtf= RTF (Rich Text Format) 2 ¥ttt
CTAN://latex2rtf

« detex (& §187]) = BIEX Bl L& A7 sto] Z29) HAE & s Eot.
https://github.com/pkubowicz/opendetex,
CTAN://detex/

71231 Pandocel2h= 20| Qlnt. o] 230 thsi M= E | 2 Folisto]
ARttt 2.4742 ¢lo| 7] vldt}. PDF A2t} n 2 27]of gt A2 2.68 S Het,

2.3 File[>Save As Template(]Z3 22 %)

BEX ‘5300l 2ol M2 e BEX 17128 BhEs A
2 W9 oA Biet Exjo|t},
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1o,
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iu)
=2
o

[¢]
=
R
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2.4 File>Import(E°127])

Pandoc &50]#| https://pandoc.orgol Tt} 22 80| it}
oty Eefo] upd-S o2 Zuj o 2 Wgtsle $obH pandoco] THs £ 67F (S leat 7101 2t (swiss army knife)
Htt.
Pandoc2 BIEX £A1E A/35he 2838 fig7|oln, 2otk %] 7] gh=tt. thest
Eofo] EME 2L HMSkshe o] W4l 2ol
Pandoc®] 7|2 X2 Markdown &7oltt, o] xufo 2 HE KXo Z o] M
£ o] FojRITt o] & So] B}, T30 Ho|= A2 Markdown O 2 ZHAJ 5 FA{o|t},

title: |

This is the title: \

now write the rest
author: Guido Gonzato
date: August 2023
abstract: |

This is the abstract.
<!--- This is a comment. -->
[comment]: # (This too is a comment)
# Section
This is **bold text**, this is *emphasized text*, this is normal text.
If you're bored, go to [The End].

## Subsection

This is “verbatim text'.

6 FILE %+


https://www.ctan.org/pkg/latex2html
https://www.ctan.org/pkg/latex2rtf
https://github.com/pkubowicz/opendetex
https://www.ctan.org/pkg/detex
https://pandoc.org
https://en.wikipedia.org/wiki/Markdown

# The End

My dad used to say:

> Damn, Pandoc has not been invented yet!
but not it has.

<l--- end of pandoc_ template.md -->

o

o] A= Autd 7153 BIEX AA R vl W o2 HeS Ul

pandoc -s pandoc_template.md -o pandoc_template.tex

EEX S 72 o] AAE A PDFE 45t W ofe WS Yo

pandoc --toc \

-V urlcolor=blue -V toccolor=red \

-V geometry:margin=2cm \
pandoc_template.md -o pandoc template.pdf

-V RO AZFSHE 2 34E A5k Aoltt. Mgt A2 Pandoc AH A& Bt
Pandoc& o] &35t t}aFsh Luio] BA 5 KXo 2 HEE 4 Qith, 2 7H4] ol &
SolEZoh

$ pandoc -s index.html -o index.tex
$ pandoc -s text.docx -o text.tex

$ pandoc -s text2.rtf -o text2.tex

..and so on.

s Zeh 1t “standalone”®] oujo|c}, % 22 w12 ST WEX £A7F Bk ol

Markdownol|A #2413} k=
o] 272 2}7} 271940}, Markdownoll= ofe] 50| 913 24} 4B} 7)50] 224
2}, 425k2) 9] 2] Yol ZF Markdown Abgotct k7t 2fe]7} Ql+=6, pandoc Markdown
= 71802 342 thg 3} o] A 2sitt.
« PZ(in-line) AL $& AZSI § 2 BUTH =
o|Ao|t},
- 3 (displayed) 2412 $$ BT} $$ 3 Atooll Ao =

o

o 23

fol

5 2409

i

=$7

ol

w5 4419) Bol 5,9} 2ol Ano] 22 Butoh ki A wlo] ol A 2ol ORF 822 MarkdownSl W Jfee]
SHLFR! 2

o 228 78 4 e, Waole] TAL 9ol olola] nholch, Eolstl Eag L% Mullimarkdown \\ (61 \)

%% 44/ Yol e polof gk £AI7E ek, ZAHE \\) F100 icko] 2 200l S5,

2] & 4418 Mok Sk amsmath 2] <aligned>2}F 20| <equation> WHollA & 4=

3= Markdown 241 & 24T of o0& M2 koTpX TH7| A& 2 E5H| 8H= Aot}

title: A=
author: A=At
header-includes: |

2.4 FILED>IMPORT(E0{27]) /



\usepackage{kotex}

ook XalTEX ZHut o] 23ttt PandocS A3y e uf th-3-3F Zo] --pdf-engine
S4E Folof g}

$ pandoc --pdf-engine=xelatex -s -t latex mywork.md -o mywork.tex

B E Bo|| ¢t= Markdown &A1& 2Hdstal A 2]5t= A E2 B}

2.5 File[>Page Setup(zl|°|A] 24)

|2 27], A FEF, oS AA5t= LRk WHR2 \documentclassoll &4 Ttato]
E FE=7lo|t}t. £] A7]|= adpaper, a5paper, b5paper, letterpaper, legalpaper,
executivepaper 59 stUE | Aottt B2 portrait”?t 712914, landscapes

Hofstol 7427k 2] §A17 HEE HE 4 9k, oS 59 thea} 2.

\documentclass[a5paper, landscape,12pt]{article}

[ 29 X‘Mf._ counter2} dimension
o9 R0l 21X nhale W0z NAE Ha10 W Aol sLoplo] S 220 PEIX 41, IRi0lE A
A AA| o] Ax vpRl2 \setlength §g o= gt} o] -2 H4el 712-E 9] ATBA “IH2E" 2t X| A5k QI O

1o S 8 T Sl = Mz 2 20N 822 02 87|, 0|22

&hS kg i AREShE Aol geometry 714 & o §ot= o) B T of #7171 B 71 2E{0] chstAfBt 712 Efekn

o] &5t &A| Afo] =, mhRl Zo|ef 22 uietn|E Bl g2l et HofotLt,

o= Y2 e Melirlglo] QlojA] o 7)o t AT 4= Qi Ti7|A] EAE QlojRE S

Hstch, ot oo A3 AFERS o} EQl=d €5 getu| g e T2 A FAo AFEE
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% memoir/oblivoir A= geometry
of= CHE WAlo| ZaiA XAl H|O| X
{|0]0F A7 20| ULE. oblivoir 7t
\usepackage{geometry} % top of document X2 5t= fapapersize TH7 | X| & 2HHSHH &
e = QUL IH7|X| 2ME & 05}2}. geometry
\geometry{paperwidth=25cm} 7} memoir/oblivoirOllA S22 Y27 |X|=

. ot=Zio2 U QoL SeiA KK X
\geometry{paperheight=35cm} MR TS Ao AFR S A= Qirh
% or: \geometry{papersize={25cm,35cm}}
\geometry{width=20cm} % total width
\geometry{heigth=30cm} % total heigth
% or: \geometry{total={20cm,30cm}}
\geometry{textwidth=18cm} % width - marginpar
\geometry{textheight=25cm} % heigth - header - footer
% or: \geometry{body={18cm,25cm}}
\geometry{left=3cm} % left margin
\geometry{right=1.5cm} % right margin
% or: \geometry{hmargin={3cm,1.5cm}}
\geometry{top=2cm} % top margin
\geometry{bottom=3cm} % bottom margin
% or: \geometry{vmargin={2cm,3cm}}
\geometry{marginparwidth=2cm}
\geometry{head=1cm} % header space

at}

\geometry B thil thZ2d f7|#] FHE F= = Ao

\usepackage[left=3cm, right=2cm]{geometry}
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https://www.ctan.org/pkg/geometry

2.5.1 Page Setup[>Headers and Footers(}slc HF)
fancyhdr H7| A & AL&-5}H \pagestyle{fancy}at= HH S & 4 JA Boh 0 A
o] A hol] Al  — book.clsztH #(chapter) — & dHF+= FTHAF e} 5hctof mo]A]
WS el Sl mE g Al o mofo 2 phsol ). Aottt Mg AL Al stohe
Aw 7ssit), 2t iF 4o 9%, Thed, 2% A REo R LAshEy)|, 7 B
A% 9, shed ¥, 2% Yo| 22t Mg Wt b BN E B

\usepackage{fancyhdr}

\lhead{} % empty

\chead{Hello, world!'}

\rhead{Page \thepage} % page number

\lfoot{}

\cfoot{\textbf{Hello!}}

\rfoot{}
2.6 File>Print Preview (&3 n]g|17])
U FEu st pdflatex ==+ xelatex, lualatex 2 PDF TS HEE THE-0]A] 2}4l 0]

£7] 2= PDF R|2| 27| A4S A¥gstd Hr},

hyperrefo]tt url 22 sj7| A & 2H B2} 74535 PDF otd 2 BHET o]9f
A= 41882 Heb ey pdflatexoll Al A8 H7| A& ALS S of 2418 He &
U, 12 o] ok AT 2hA IS AL 4.14 0l A Th2 T

2.7 File>Print(4})

ZHil o] Ab&-5}al Q1= PDF v] gl 7] 99| w0l File[>Print &%-0] 9l& ZAoltt

2.8 File[>Versions(H{A &)

H7 o]y He|t 35 LS st =2 aslo] W 7] Qlt}. old AL & A5 5t=

ZAFE A27HE RCSE2 T A2 2 ol o= AT 2R FX st
Z AFEAFS A Y 5H= Subversion, Git, Mercurial Z+2 =17} ¢ W}, Gito] 7} o]

AFGEIE 2Rl BEX 8 Telo] BejAl s ohe BAE Fustet.

o https://www.desy.de/~bargheer/gitintro/git.html

(%19 e moir/oblivoirofl A= fancyhdr
Qb= C}Z gtAlo| ZafA XHA| ‘H|0|X|
AERY MH HEAIO| QICE fancyhdr®f
SEE UK Y= AR AB K
QlOLt SefA Q| MM utAl 3 S A|of At
£ giCh

EF 10| om0l M & Z3H= HHOI GllAIE
OiIT fancyheading | Z40|C}. ¢4xH <]
fancyhdr O HE 2 X507 | = ot
EI=Z \fancyhead, \fancyfoot
FPO = dYst= 20| ELf. B9 LH

Z2ME CIXfolEt mjof] a1 2{stCt,

|
x|et

-
[ofz1

IXXH= Eps D8 AQlS
Aoz E‘J'Et LFE Atetg elgsta QUK

OJEE‘ OE pdflatexoﬂ)\ﬁ e

ST Q| TeX Live A|AEIS AL X7} O AlSLHX|
SOt EPS 7S PDFE H2tsto]

Lot Z= Ol XE 2t of QL

« https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.

html

3 Editd¥%

o] wl ol sgshs A2 BIEX Q] 7]-5-0] otz w3 7|9 ehadd Zlo] gt WA & 10
A, Zetg7] - EAlst7) - 2ol 7] - 2 7] - Zhobubat 7] (Edit[>Cut, EditD>Copy, Edit[>Paste,
Edit[>Find, Edit[>Replace) 5l sl ot= 2 7HA] ot & 9] 7|HlQld S Au e},

2.6 FILEDPRINT PREVIEW(Z3 0|2|E7])


https://www.ctan.org/fancyhdr
https://www.ctan.org/pkg/hyperref
https://www.ctan.org/pkg/url
https://www.desy.de/~bargheer/gitintro/git.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html

A2AL 2ol WAL 517] glalAo)7| = sHA % o] 54 ArtdS A steln
HAES e o7} ok BIEXOIA olo slgal dde FuE R SeKAL 87
gol Y Aolt}. o2 W AR gaEo] FE A} £42 RojaielH O oA £ &
742 lo 2 st

this is \textbf{bold text;}\\

this is also this is bold text;
{\bfseries bold text;}\\ ..
\begin{bfseries} this is also bold text;
this is bold text, too! this is bold text, too!
\end{bfseries}

3.1 EditD>Autotext(AHs&A)

].
o} 7| x}Eek4ole} st 712 oAt ‘PS’ebal Eto] W5l ‘PostScript’ 2H 1 7\}50 2
Aol Qe 22 watt}, og ez} o] AL sjFE}. BIEXOlA ool sigs
AL oz oha 22 7ol

\newcommand{\PS}{\textsc{PostScript}}

o] ZA| o] gt th-3of \PSet1 5= 2 \textsc{PostScript}etil YHsh= 2t
2t} thaga o] Fasitt

4 Insert ¥

o2t
)
il
p—

4.1 Insert[>Breaks(

.+ o] Lhiro}7|%) b BUBALE ~ (Yu) 2 HATT

o
=]

-

i
[
ac)

o A 3 U7]=\1inebreakt \newlineS &t} E9] xlo| &= o}gj H7| FIIHH= \\ 2 \paret 2F 8| S
L =] | = AN L - o = A ‘|9 AjH |‘19,\IOL|'01X|’E 1%}”
E=N\2A Y Y72 g et o= 8 14 & sgHo2 & 4 Aok MZFSIX| OF7| 20|l 0] 2O 2 RAC}

‘“14 \\E HZHME (BHE & +A)

>U

lcm]). I 74
A\ D \newline} 2| ZX|2t I (array,

~ " ing S)0iIA = oIxh & 9
« M2 EEE AZeEHE S5 FAU \par §8 & & t—ézbﬁugfﬁ;%né o e

. 202 Ho|A & Y+ \newpage == \clearpage Ho| tt.

\newline®} & \linebreak= x| 4 2717 -t

!
I am stretched!\linebreak I am stretched!
But I am not.\newline But I am not.
Another line.\\ Another line.

Ok, now you get it.

Ok, now you get it.

3HH \clearpage”} \newpage®t T2 H-& Ax| 92712 HEEo] Qe ZZE(TL
oy )5S B F Z¢ ool o] & UeTh= Zolth. SR Eo| tisiA = 4.14%F
ol A g gict.
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4.2 Insert>Enumerated List(H g8 JI 2
Udd Et(list)oll= 22 1o A (bullet) & £0°]& <itemize>t HSE €0|+= <enu-
merate> 2730] Itk " \item HHol| ¥ xS Bojslo] UdF Eho] 2ok mjg
7|55 o2 RO 2 g 4 it
bl i) * with an asterisk;
\item[*] with an asterisk; ’
\item[-] with a dash; - with a dash;
\item[.] with a dot. )
\end{itemize} - with a dot.
Zt FEo| ZAE = 5 WY (A BFS vt EOE 2 gl AE |
RE| 45F7H2) B 712 E (counter)! 2EHAS A et Aok \labelitemi,

\labelitemii,\labelitemiii, \labelitemive=

itemize 730l G5t \label -

enumi, \labelenumii, \labelenumiii, \labelenumiv+= enumerate2] 24 7}-2E

~ERgoltt,
7he) AErelo] B E77}
A ClE

2t} \arabic ‘YHF £2ko] il \ roman-2
£ 82 viiiZ E7]), \Roman< A ZoF =2} \alphet \AlphE 212+
sl AEApel gubel tiE o]k kol \ fnsymbolo|ghes A&
M= Yzl (163 0] %)) A stal

4Rt 2o

sl ol el
ot

\begin{itemize}

\end{itemize}

\end{itemize}

\renewcommand{\labelitemi}{*}
\renewcommand{\labelitemii}{-}

\%tem f%rst level, %tem 1 * first level, item 2

\item first level, item 2

\begin{itemize} - second level, item 1
\item second level, item 1 .
\item second level, item 2 - second level, item 2

\item first level, item 3

* first level, item 1

* first level, item 3

enumerate 2]

Eof| A Zup exbel thEAt SutslS 22 thgt 2o

ol
H

\begin{enumerate}
{\Alph{enumi}}
{\roman{enumii}}
\item first level,

\begin{enumerate}

\end{enumerate}

\renewcommand{\labelenumi}

\renewcommand{\labelenumii}

\item first level, item 1
item 2

\item second level,
\item second level,

item 1
item 2

Tl ofshel W&} B g

Fll’
_{\1

12} 712 B 2 74A ) Elof .

o=

BF 1< description>2 2 t2[0f (S
QX2 FOIE) HAES 1 M FA Q|
ZHhe BhECH

AF 1] oTeX I oblivoir s 224! 71 2F
A

F2 MS2Ch 2 F0fl= \gana,

a, \ogana, \onum, \pnum S0| !C}.
FeH 2ol o 7H Oh, @b, ©, (12
tCF,

JOE
=)

A
T
\pga
2t2+
1
=Y

A
rob w

4.2 INSERT[>ENUMERATED LIST(HS £
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\item first level, item 3
\end{enumerate}
A first level, item 1
B first level, item 2
i second level, item 1
ii second level, item 2

C first level, item 3

k2 W 0 2 enumerate T7] 2| 2= W o] ot ' <enumerate> B2 A
Al skt Aali17Fd 222 &

A AAFZE XA SHHA 2} 71-2-E| 9] & Alo] Z+ZF \Alph, \alph, \Roman, \roman, \arabic
Eg Zolsteld 52

ofsto] G4 QA G2 ME AU A HE 4 9

o2 tehdt}. 7 32 vejo] W ol9]o) Bl

E-Q‘E- ?‘TO-]_\L"E]'

\begin{enumerate}[{Example} I.]
\item First example.
\label{item:first}
\item Second example.
\item Last example.
Go to Item~\ref{item:first}.

Example I. First example.
Example II. Second example.

Example III. Last example. Go

\end{enumerate}

to Item I.

\end{enumerate}
5 o2 24 A2 v S e & A esta).
\begin{enumerate}

\setcounter{enumi} {2} 3. Example 3.

\item Example 3.

\item Example 4. 4. Example 4.

\setcounter{enumi}{5}

\item Example 6. 6. Example 6.

H Ho}. <in-

I'll throw in a list of items:
\begin{inparaenum}

\item apples,

\item pears, and

\item oranges.
\end{inparaenum}

\begin{inparaenum}
[\itshape a) \upshapel
\item apples, \label{first}
\item pears, and
\item oranges.

The same list can be labelled with letters:

The first item is \ref{first}.

(% enumerate IH7 | X| 20 o Z&3
7|58 ME3sH= enumitem 7| X| = ULt

[A4F17]

memoir 222 = enumerate
IH7|X[e] 7lsE Bt Rleoz2 HE2
2o =Tt gt oblivoire

7h e, @, 7,00, 9,1, O, @), @

2h= &5 H2| XIAIXE F715t QUL
oblivoir 7} OtL|2}H koTpx Z=7t THZ|X| Q!
dhucs-enumeratelt dhucs-enumitem=
& nstet,

INSERT M|+


https://www.ctan.org/pkg/enumerate
https://www.ctan.org/pkg/paralist

S5 2a BHX 93 RS

$ \$ or \textdollar
& \&
% \%

\_or \textunderscore
\{ or \textbraceleft
\} or \textbraceright
$<$ or \textless

$>$ or \textgreater
\textbackslash
\textbar
\textbullet
\textdaggerdbl
\textdagger
\textparagraph
\textsection
\textcopyright
\textasciicircum
\textasciitilde or \~{}
~ $\sim$

® \textregistered

™ \texttrademark

2 \textordfeminine

° \textordmasculine

>0 Mttt o — -V A

R

SEAE B Y

==
Jm
i
rr

\end{inparaenum}

I'll throw in a list of items: 1. apples, 2. pears, and 3. oranges. The same list can

be labelled with letters: a) apples, b) pears, and ¢) oranges. The first item is

a.
el clol 50l Aali1 BV} 4 A2 ABHRAHEH £A2 S
paralist'= o|8ol = Chfer 42 & 4 9002 71X BAZ Yol g Wkch,

4.3 Insert[>Special Character(54&4})

wﬂ'HANEnhmngEw&qmaﬂ& £ 32 7198 o] 2AH5L ool
2ol 7Lt 43t BEo| A AL of B4 viARE Abgstelof St E 25
Ea.
e
581t
=3

s
T

)

23}

24

rlr

th2 B o 2 ASCII ZE9F \char &S 2= Zlo] it} o
7}YZF\char36 \char38\char94 \charl26°]2}1l ¢]&35}o]

i

.
Mo
i

>
il
ilo

ne
o 2
;O

AOFo EH
Tﬁt?

rm

AU 7125 Algohe H7]A = Ao A& & pifont 7| A=
\dingT} \dingfill, \dinglint, \dinglist H§&S 2311 . \ding HH2= EH
F o] Jul(Dingbat) A2 A=t \dingfillZ} \dingline& \fill®} \lineol
o33ttt \dinglist 2742 QIAtE Foi7 8l FEE & W2 AMESh= Y AES

o]
=

opEr
N

S
-

ot

™
Ny
l

AR

7t
tE

"oblivoir 54+ T{7| |2l xob-paralist
A enumerateOfl CHH A

Xz ot= 2gE 7
S FMH &L

4.3 INSERT[>SPECIAL CHARACTER(EL2X})
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https://www.ctan.org/pkg/pifont

RHEC)

\begin{dinglist}{43} 5 one
\item one
\item two = two
\item three
\end{dinglist} 1= three
2 1271 9] dingautolist 72 017l Q1 Ato]| sligsh= ¥l T ERE| AJ&F5to] 2]
AES WE= B 752 A5t
\begln{dlngautollst}{172} @ one
\item one
\item two @ two
\item three
\end{dingautolist} ® three

713 A= U EotA o7 A o AFE 4 ¢lch. 1 thAl “The Comprehensive BTEX
Symbol List' 2= &S 471518 3ttt CTAN://comprehensive. "

43.1 A238715(€)
S koas
7Fsaich
\usepackage[gen]{eurosym}
\usepackage[official]{eurosym}

eurosym 7| X 2 A2t 4= =], ohZ3} 2 F 7HA] WA 0 2 ARS

rlo

A
T

- H5\euro BHP S Alastl 124

A3 €9} 2t} o] 7|57} e mapo] &

A { of whet 2t [gen] ML FH ZE T)AQloj 2§23} 7|52 A},
HHH = HA) B9 A2 €2t RS Qlafigttt. v]B3k o] 7} it \officialeuro
%“’—32 o Ao HEA] o] ‘official euro’ Y-S AE 4 Ut

23} 7] 3+ marvosym 7| X o A = A F-5k=t, o] mj7] 2| = o|gto) $E2 B

712 EE AHSSHA Stk \EUR B 2 & €5 sl = it}

4.4 Insertl>Formula(538H4))
BIEX S §3] 424 9] Z23to]l Z7o] ik, 43t 7|52 glaEe] gre — olgfo] mE
(inline mode) —Z o™ ¢ 252 1 AJZky} £-& vhephdch

I like math: $x”n + y”~n \neq
z”n\ \forall n \neq 2%
is my favourite theorem.

Ilike math: 2" 44" # 2" Vn # 2

is my favourite theorem.

VAN
QL
T
Ry
*<
3
Q
=
V4
1,9
VA
o
[
I~
8
S
S
\V4
rot
o,
rlo
0 4
o
ik
o
re
Sl
i)
e
H
Sl
o)
|o
Fu
Y
i
et
iu)
o)
>

(HF)7eX Live 2 A X|UCH &2i2of| A]
texdoc symbols = texdoc
comprehensive %'%4 2 Li2i=2at

(S50 olstot oSl S LIEHHE 7|5 W, ¥ 2
\textwon, \textyenQZ 1S % QIC},

(%21 amsmath IH7|X| 2 2= 5HH
\eqref FEE £ = UL ChS ool A

“Eq.~\ref{eq:fermat}’2t1 st EES
\eqref O = HIH Eq. (1)2 20|

LIEFETY,

INSERT M|+


https://www.catn.org/tex-archive/info/symbols/comprehensive
https://www.ctan.org/pkg/eurosym
https://www.ctan.org/pkg/marvosym

Fermat's Last Theorem
defined as:
\begin{equation}

X*n + y*n \neq

z”n\ \forall n \neq 2
\label{eq: fermat}
\end{equation}

Can you prove
Eq.~\ref{eq:fermat}?

is
Fermat’s Last Theorem is defined

as:
"yt #£2"Vn#2 (1)

Can you prove Eq. 1?

4.5 SymPy AF&H

m2ae) Qojot AL EAEL 44 Qo] HE 24 S ALEAT SymPyek wto] 4
2

7} T, B B2 S5 EYE 2e E

=

3 = x X
2 SymPy oflAo]th, 9 4] (£ — 2) T RS WM L - LE 4 22
(o3}

3
82% ol oH%Fon BEX 155

X 42 22 & 3l mtojdo] 458

In [2]: init session()

types: python)

>>> from sympy import

>>> f, g, h = symbols(
>>> init printing()

In [3]: expr = (x/2 -

In [4]: latex(expr)

Out[5]: "\\frac{x"{3}}
y~ {2} - \\frac{8 y"{3}

In [1]: from sympy import *

IPython console for SymPy 1.9 (Python 3.10.6-64-bit) (ground

These commands were executed:

>>> from  future  import division

>>> X, y, z, t = symbols('x y z t')
>>> k, m, n = symbols('

Documentation can be found at https://www.sympy.org

Out[4]: "\\left(\\frac{x}{2} - \\frac{2 y}{3}\\right)~{3}'

In [5]: latex(expr.expand())

*

k mn', integer=True)
'f g h', cls=Function)

2%y/3)**3

{8} - \\frac{x™{2} y}{2} + \\frac{2 x}{3}
27}

ojA| o] A2 RE dojA= 42 ot E 2 BAMS o9 7|tk & \\& \Z =

75k st ek,
ghof nho] 4l Qlojo] S
BESAWRE AT 2500

S python BIEX 7] 2]+ LaTeX Expression project

4.5 SYMPY AF2H
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https://www.sympy.org
https://www.ctan.org/pkg/python
https://mech.fsv.cvut.cz/~stransky/en/software/latexexpr/

4.6 Insert[>Footnote(Z}3)

Z o3t 22 \footnote[n]{footnote text}et= W Wolr} 4 A}l [n]= 2
F HSE vttt \footnote P2 Tojet npyE, 4 H, 7|e} EHE S FHof] Fojof
Sig=

M Al 712 e Jojo] HAES Zb3 7| S 2 ARG \footnote 7 EHE

\renewcommand{\thefootnote}%

dreee] mad) This footnote™ ™ says it all.
This footnote\footnote

{I mean this one.} readme'y 1 ean this one.

says it all.

ol Wl ALY 25 WB g Rouleaht 7| SRAR Uehd 4 Uk,
\renewcommand{\thefootnote}

{\Roman{footnote}}

This\footnote{The first.} This' is the first footnote, and this" is the second.
is the first footnote, The end.”

and this\footnote{The second.} ;

is the second. Hﬁz fzz(tmd
\renewcommand{\thefootnote} At last! ’
{\fnsymbol{footnote}} ’

The end.\footnote[8]{At last!}

\fnsymbol{footnote}=til 3t H z}
747}t o} F Jle] 7| S EA 7L mE T, « +
SAgk zhol tleiA M2 e 2 22 HEs g ool Y 23 HEs

W7 23 Thg 7} o] sl

This\footnote{the first.}
\newcounter{\myfootnote}

\setcounter{\myfootnote} This' and that® are footnotes: please read note!
{\value{footnote}} again.

and that\footnote{the second.} ;

are footnotes: please read note ztheﬁrst

\footnotemark the second.

[\value{\myfootnote}] again.

59]: minipage U0l = B h= BE9| 25 7F-E & 2h=tl|, mpfootnote©|tt.
\thempfootnote® 1 7S Q2h3F 4= U}

4.6.1 Footnotes and Endnotes(Z32} n]F)

endnotes 7] A= \endnotez}t= M2 HHPS #| L3t} o] WS \footnote A}

gof] thAl 22 H|o] 7] sltof] ZkFE o= th4l \theendnotes H& o] Fo|+= 9o
Zota A ESCH! Zolut Ao npx|ghof M-S ot Q125  ujjof] -85}t

INSERT M|+


https://www.ctan.org/pkg/endnotes

\footnote §H o2 U F o] 9
a137) YsiAE e Lo e )

lo
Il
N
:?L_’,
A
u)

\let\footnote=\endnote

2] 3 ofefet 22 Al 20| WS LA vhxstel Hof Pt} 2

\newpage

\begingroup

\parindent Opt

\parskip 2ex

\def\enotesize{\normalsize}
\renewcommand\notesname{O|F} %% HA} 7}
\theendnotes

\endgroup

Ak the 3} o] LR,

e

fo]zte olzolt}.

4.7 Insert>Indices(Ex})

8 =3, B 23}, 1% 23 52 AASHE 2L XA UL 2kt Yol the
2 onl

=
B2 249 A MA \section E= \chapter Fo| L2 7] Hoj Hojd

\tableofcontents
\listoffigures
\listoftables

W7t ob o 9= 2 Aol olejdt 75 o] gtk Y= Z2 A Aol SQIE] KEX

2
N
N
9
4
2
2
&
o
mjo
[
N
i
[
&

(2 gndnotes S AIXFE If 2= EfO|S
O3 2= \notesnameO| 11 7|£Z}0|
“Notes” 2 E|0f ULt 07| M ot=0{=2
Hoi5t7] 2/8f 0| ({2 2 E renewcommand
SHRALE.
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F 3: <tabbing> $7ol| M AHEE= H

L &
\= & AF A& At
\> O § A5 X2 o]53tt.
\+ B AE AE T e 2F0 2 Hint
\- AR AR E ST dF o 2 G
\\ 3Yo] &
\pushtabs EE ¥ AF & A4t
\poptabs  AZIH & AF A& E=j2Th
one.\hfill two\\ one two
\vfill
~ \hfill three \hfill
- ~\\ three
\vfill
four \hfill five
L four five
Ui o2 PRI ME B ol4e] B EH 02 Yol m IAS BYaiA Lg%ur
E oo Ful g shuke] Fuo 2 7hEsich ey EA9] Ft o =l E A
335 o] 4ol Zule A 2 Wojof Shrhd, “FatA x| G B ~ REE A}%ﬂa}.
Zo]E A Hsto] Fulg dod b \hspace §H S &0} »
This is a \hspace{2cm L. .
. pace{2cm} This is a 2-cm-wide hole.
2-cm-wide~~~~hole.
4.9 Insert[>Tabs(§})
<tabbing> $732 TAB 7|12 5312 0] S&3 §Ae 472 Ao}, drEs I
(column) 91%] 2 Wjx] 5H= B AR BT B 3.2 o] B0l F2 2o = WS QokstL
AL,
theg Tt R ARge o Alolct,
\begin{tabbing}
s © 9i2g 43
~ \hspace{lcm} \= ~ \hspace{l.7cm} \=
~ \hspace{2.2cm} \= \kill % O| HES HA|G}A A
Zero \> One \> Two \> Three \\
Zero \> One \> \> Three \+ \\ % &I 7t Q=& 0|Z
Zero \> Two \> Three \- \\ % St ZI¥4 2|Z 0|=
Zero \> One \> Two \\
\pushtabs % % |z A2

new tab 1{\dots} \= new tab 2 \\
new \> tab \\

\poptabs % A& B Qx| EH
Zero \> One \> Two \> Three
\end{tabbing}

g

ng [o o

otrnpE W

Z| ZtAH0fl CHSHo] \vspaceE &
= == UL} CH2t \vspace=
SEE 3ol (H 3L ZsHA

vertical modeO{| A{) A{OF BtC},

=1
=



Zero One Two Three

Zero  One Three
Zero Two Three
Zero  One Two

new tab 1... new tab 2
new tab
Zero  One Two Three

<tabular>2} <table> &7 = Lo} H A},

4.10 Insertl>Cross Reference(22}&x)

gAEo] eplll S g1 2pl QJx| &2 wAtkxs}7] lsiA] \label, \ref, \pageref §0|
AHEEITE 2L prefix:suffix P41 22 o] Sl Zlo] EFEH 0|t} 7| prefixe o !
S =9 o33 2ot H(chapter) HE Ol cha, $4] M &of eq, 17 oll&= fig, A (section)

-~

of| = sec, &0 tab.

A, #, 39 5°] o A& #Ho|AE FRoHHH \labeld \ref & th& E7]ek Zo]
ArgEr.

\paragraph{Example.}

WEIEUEIFEE GO Example. This paragraph ap-

This paragraph appears in

Section-\ref{par:example} on pears in Section 4.10 on page 19.

page~\pageref{par:example}.

22 prefix 5 A4l op2o] E= Z o2 = Hrt. enumerate 2| AE0] A8t
olg Bat.

\begin{enumerate}
\item{first step: skip to
\ref{item:end}
< \label{item:start}} 1. first step: skip to 3
\item{another step
< (unreferenced)}
\item{end: go back to 3. end: go back to 1
\ref{item:start}
— \label{item:end}}

\end{enumerate}

2. another step (unreferenced)

4.11 Insertl>Margin Notes(o¥2)

Y& 7rebsteh \marginpar{text}g}i 2H Hr}, o] 7|5 Q& mR A Ao AL Z
27] o2l Aol B}l El

4.10 INSERT[>CROSS REFERENCE (A=) 19



4.12 InsertD>Text Frame(Zd|Y)

(]

ZHJoz SR HAEE £ dRE FEHAA UEU 7] 98l 22o]=t Ho]A]
AFolof A Utmof A A] ¢k Ho]z| o] 1A H flx|of FlAE T3PS F2H textpos
o712 & o] g5t Hek » 1 Oﬂxﬂ £ 3" A5(FE A)oll B3Th

_CL rlr

L
L

BF sl otz absposHH9|X|E—jf— BT
£95| beamer0i| M textpos7t 227 |=
Ho] 2] /o] £ glxjo] GlAES 3 SAE ma - 2,
BAIZI= Zlo] ot e <minipage> ... Ol HAE = njyd|o] x| & HrA
(Y olA) &4 2 & 4 Aok A= 2 4 Aoltt. <boxedmini-
B3 Q= HIAE = minipage 2 TH& page> 74 0] 72 o] 2] wfj7| %]
o7l Zlo]t}t. minipage BfAE 1 A of| 2|50} AT =},

oloi|A] o] %] 7} Lirof 2] %] oF
<minipage>At&12 ot Z2 FAUYE Z7I5HAE
\begin{minipage}[position]{width}
iéﬁd{minipage}
<boxedminipage>°llA| Ze| Y} HIAE Apo]o] IHA L th-Z o= A3t}

\setlength{\fboxsep}{5mm}

4.13 Insertl>Image(°|n]#])

z0): OJE)X] (image)2t 18 (figure)}& THE Aol AMIE AL 4148 S K},
PDF, JPG, PNG, TIFF 2° 5} 2 % o]n| x| & AH9l&t 4= 9It}. PosTscripTU EPS TFY  BF 26 mxt= TIFFE 07| M 9123t D
5 5 UL T TeX Live A|AE2 TIFF Z2HO|
= Z3tote 3“4”‘ otut AFEE Zob= Al Ao 23lo] o] ot & A 2|5kAY OIDIXEZ Hgﬂoﬁm oFCh T sl st
PDFE Hglel= Wb S okm 9) 8 Ao|c}, EFE 0|&3t0] PDFL} PNG £ convert
e Si2=0{0f BICH,
725t 1 7] 4] graphicxoll A #|3-3H= \includegraphics H 2 & o|n| x| & L g}gt

4+ 9k,

[SF2onjo| x| 2= 125 H Dt
This is a lovely picture

This is a lovely picture
\includegraphics[width=3cm]{piper.jpg}

of a guy playing the pipes.

of a guy playing the pipes.

height, width, angleZ-> T2t0|E| & £ 4= Utk widtho] A7 ©9l= 9l2] H 7]
M H Aol & Fole H HAEL Y Zo]of] JTUigfoz Fojsfj:= Hr),

width=\textwidth % THO| F= H|
width=\linewidth s A 2Hol =& YH|
width=0.5\1linewidth % linewidthQ| ZHt

& 7k e R BE JE = vl 2|52 adjustbox 37| A& thgofl B9 &3t
@Wﬂ EEE} H A

20 IS


https://www.ctan.org/pkg/textpos
https://www.ctan.org/pkg/graphicx
https://www.ctan.org/pkg/adjustbox

\usepackage[export]{adjustbox}

adjustbox T 7] Z] o] [export] &A1& FoJsto] =514 \includegraphics ol
left, right, center, outer, inner?} -2 A4S F714 0 & Bogh 4= Qlct, npx|dt & 7o)

S4e T Bl aEoA 22 Ao},

This is a lovely picture

\includegraphics%
[width=3cm, right]{piper.jpg}

of a guy playing the
— pipes.

This is a lovely picture

of a guy playing the pipes.

H| ERY o]n| 2|7} PDF #]§] o]n|z]of] H|5}of FZ o] ZHA]
A7 2YsiE g5 AR

283 O olm A&

[9 2} adjustbox+= o ThFStH 752 A5
FAE FedAEELYeH, B T2 =
sf5= [Export] = 3Utt.

vertical align®l &3t ol & 3Lt So] &

Zict.

27 2 A T deE Qo
R

Sk mfj7|xlolct. 7| A& 2= uj [export]
2/S \includegraphics H& I} g7 24

\includegraphics[height=12pt, raise=-1ex]{piper.jpg}

8ol 4

S} %

zolg

olct.

4.14 InsertD>Figure(ZXx)

T3 (figure) 8732 0]1]X] (image)E AU He
g o x3t it figures Ho]A] W] 1L
HSof tfsto] mabgx
o] <figure> g7 olt}. otfjol & FF figure©l that ol &

go] ojn|x|Y
mHrhis Zo]n] B8 Zi4o] 23119

\begin{figure}[htbp]
% [htbp] E2E7t =Y A& AY
% here, top, bottom, separate
< page.

\centering

\texttt{=8-)}

< ADpe)}
\label{fig:mysmiley}
\end{figure}

\caption{O| QAN HAE LtERLHE

FEdloF & AL, figure= BIEA] &

9lth= Apalolch, -r_]E = 2 M| A2} B] L sto]

CE
—=
A

o]
H
Al

=]

c}

A5

2] 921 £ gl =l tistel 2ol & w7t gl
A2 raise keyZ Y219 \includegraphics 7|2t} UhFo] A As|of st 7

A} ¢

Z

Hol i},

%ot AMd figure o] Y-
H 54 /A E Z= Aol okt
23 4 Qlt}. o] A& sk

=8-)
a7 1: o] A MRS YER=

snfele]

s
=
=

F2 1 9ol Lpehdths Bo]

H
Aol figuresol 178 AR E ZA|

F 2B HXH= “multi-column text Ol
MO 0 5t QUoiM 2 XLt O]
HE22 MAte| &zfel Totrt, Hetet 90| =
twoyde(%*ﬁ) BIAEO| M3 1 8ljof
STt & inner2ts 22 ﬁH%(spme)

(RLEZ mo[x|9| & 5—5.]11|0|X|O|
9_5—?) outer2t= A EXUES
7t2|7|&= Zo|Ct.

e
_|

AN

|z

—_—|
O

AN

4.14 INSERT>FIGURE(& &)
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\begin{figure}[htbp]
\centering

‘Gnuplot 30 graph

\includegraphics%
[width=0.7\textwidth, angle=-90]%

{gnuplot.pdf}
\caption{Gnuplot I2{=}

\label{fig:gnuplot}
\end{figure}

o
15}5] S48 920l £ ATH here 171412 AHEE 4 1=t o] W71A = H(“H ]

pUI
o)
e3!
=
=
o
1
rlr

seold) 912 A1 A S Al

= =l
a7 33 22 Ants Ag 4 Uk P

732 AHgstol

\begin{figure}[h]

% first subfigure

\begin{subfigure}{0.5\textwidth} % half figure for 1lst
\includegraphics[width=0.9\1linewidth]{piper.jpg}
\caption{Caption of 1lst subfigure.}
\label{fig:subfigl}

\end{subfigure}

% second subfigure

\begin{subfigure}{0.5\textwidth}
\includegraphics[width=0.9\1inewidth, angle=-90]%
{gnuplot.pdf}
\caption{Caption of 2nd subfigure.}
\label{fig:subfig2}

\end{subfigure}

% whole figure

\caption{& 72| subfigureE 7|2l figure}

\label{fig:image2}

\end{figure}

2o A &5 B 283 T E= 182 wrapfig T 7] A & ©]-8-5to] +&

(% 29] 1 emoir/oblivoirOll A= here

7| XS AFESHA| 4Lt
(5550 5ubcaption 2|0 = subfigure,
subfloat, subfig S subfigure 7|5
HSdt= I |X|7F R UACH
memoir/oblivoirOl A= XtH| BHO 2T
subcaptionS & == 11 0| M7 |X|E &
& Ao

(5591 wrapfig2ets 17| x| = fefol
wrapfigS 7§48t 20|}, wrapstuff
dEY ohsiCt

Bror J21S marginOfl &= 2401 240]
UCHH <marginfigure>ete 22 S
H|Zdt= W2 [X|7F R AL memoir”} 0|
SHE 2 KHA| X[ Y8t U1, sidenotes,
sidenotesplus, keyfloat 50| 22 0|E2]
etE 2 MiSetct 71X 2 ME EHostat



https://www.ctan.org/pkg/here
https://www.ctan.org/pkg/subcaption
https://www.ctan.org/pkg/wrapfig

(a) Caption of 1st subfigure.

Gruplot 3D graph

SinGeex + yy)ioex +

vy ——

(b) Caption of 2nd subfigure.

1% 3: = 79 subfigure S 7H figure

If you meet this guy, give him some
< money.
\begin{wrapfigure}[4]{1}[5pt]l{2cm}
{\Huge

~\texttt{=8-)}

}
\end{wrapfigure}
The reason may not be clear to you,
but I can assure that your money
will end up in good hands.
I say again, if you meet this guy,
give him some money: he knows how to
use it properly. OK?

If you meet this guy, give him some money.

=8-)

The reason may not be clear
to you, but I can assure that
your money will end up in
good hands. I say again, if
you meet this guy, give him some money:

he knows how to use it properly. OK?

oA Ak TS 7] skl 2L Folok & Aol 4, 10| £ 91 (hibpst
22 QR A A AL, Boju7] Ao|, 279 Zo|tt, "32 (55592 rapfig | QIXIXIHAH= 1, v, i 07}
QUCH 2zt 2o CHstof 1%, 2%% obx,
Jﬂ_fé—.olﬁf glojojct. htbp%f% |
4.15 Insertl>Shapes(X®3%) SHLRFS AIFSHOF BHE.
PGF/TikZ= Z2|Yst5o] 283 AT 4 e vl 28 o7 Aot} &
o}z 7rekat ool ct.
\begin{tikzpicture}
\draw[red, thick] (-2,-1) -- (2,1);
\draw[green,thick] (-2, 1) -- (2,-1);
\draw[blue,ultra thick] (@, 0) circle
(1cm) node{\huge \LaTeX};
\end{tikzpicture}
ol& Tt A olelo] A& PHe A & 4 Ut TikZ.netS WEal 2et.
THFWYSIWYG 138 18] 7] =2 730] E @ 5t Inkscape(https://inkscape.
org) ZHerh. of T2 IWL PEXS AY} 5 447 ElAE 0] Q2 S BTX 44
o= g ).
Inkscape & AYsta AFst E2 =5 18 o5 Hl4woll A Extensions/Text/For-

mula (pdflate)...°]t} Extensions/Render/Mathematics/LaTeX (pdflatex)...&

EELE

4.15 INSERT[>SHAPES(=¥)
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https://github.com/pgf-tikz/pgf
https://tikz.net
https://inkscape.org
https://inkscape.org

LaTeX input:l\LaTe)({} math: Se ~ {i\pi}-1 =09 ‘

Additional packages (comma—separated}:[ ‘

[ ] Live preview

Close Apply

Eile Edit View Layer Object Path Text Filters Extensions Help
Do &8 3aE| - 0OY B @aa oa®l v
o @ iE o5 B 7| x[e2sos [J v[essassfy v
[ ‘-ZIS? [ B B ) |0\ LI I B I |2|50I [ R R ) |533I [ B T ) |Twsol [ B B ) |1‘.:‘J Q
; B
A ‘
£ 1 T*I]:Xmat T ] ==
T "
Q b
Oz _
0
® - shapes
O -
g >
0
© ] normal text LN
as
: -
e - !
AI T 3
> -[<| | m | \)]H ’
XEEEEEENT = EEE NV —m—
i [>]
Etll-;,ke; Unset O - L) [L] Group oflob|e¢ g;i ;g z:

a3 5: KIEX o] YA ZiA1 o] H A

2B+ 2 JiA 2 23tE = B estohy 2 sol|A] B Hhet
4= ot &A4E 182 PDF, PNG 5 KIgXo] A|¢st= oo 2 Y

r-‘i
n{tl
i)
1o
I
o
o
Z
oXx
ol
N
do
:oé
e
Y
i
[
&

« GLE (Grahics Layout Engine)+ S 8
o A3 e dojojr}, [...] GLE+= ILEHEQ} Y o] HAE 9 24 283 KX
of] o]&3s}aL Itk https://glx.sourceforge.io/

24


https://glx.sourceforge.io/

. Asymptote= 725 WlE] 2jg 7% Qlojolct. AU =S 27| 93
ArA A FHE 7 g e AlFetet. eyt A5 BIEX o 2 Y EST
https://asymptote.sourceforge.net/

rE rSL
]tl _li

« LaTeXDraw+ BIEX 2 9g 18 HYY 7|0}
https://latexdraw.sourceforge.net/
« Graphviz= 23 BIAE Qloj2 Jefj 5 7] &t BIpXol L3 tholo] 13
BHETH
https://graphviz.org.
ol& u}7] 2] & o] oA BIpX & A3t 28 E0) w8 1S & 4 ek ofdfol®
@t} “LaTeX vector graphics” = & A sl e},
a8 4 =530 22 o8] 717} Yot TrX Showcase B 0] 2| & WMo B H
E0g AF5Hs ol o2 BAT 4 9lS Aol

https://www.tug.org/texshowcase/.

4.16 Insert>Page(®|°]A])

B PDF H|0| 2| overfull 2] ¥ & Wz] &2 B2 AAshe 22 pdfpages 7| xS
2 g}, ohga 22 A o 2 ARgsit,

\includepdf[fitpaper, frame]{pandoc template.pdf}

o] Y2 2.48of|A EQl Pandoc 2 & TH50]A| = PDF FA| & AUttt o3 o] %]
= 9o F=E At A3t Y4 E PDFE \includepdf$t Zxtolct,
pdfpagest ool = o8] 71| 7]5-& Z2b31 Qloy mj7]x] EA S glojH &= Zlo]

4.17 Insert>Rule(FA)

gJele] Zojot £ 2 7HAE AL \rule Yoz et

This is a page-wide
rule:\\
\rule{\linewidth}{1pt}
but this one is shorter
and thicker:\\
\rule{2cm}{2mm}

This is a page-wide rule:

but this one is shorter and thicker:

w5 oz Zlog HAS age \dotfill o] Ut §Ast AL AZAS

=)
ok
ol
i
iu)

Total price \dotfill \euro~10 Total price ................ €10

o
=

L EEZE

Ax|ot=

4.16 INSERT[>PAGE(H|O|X|)
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F 3 overfull 2 ‘of|2f 7} obL|2t <A
20| ELt,

arojLt,


https://asymptote.sourceforge.net/
https://latexdraw.sourceforge.net/
https://graphviz.org
https://www.tug.org/texshowcase/
https://www.ctan.org/pkg/pdfpage

This is the title:
now write the rest

Guido Gonzato

January 2018

Abstract
This is the abstract.
Contents
Section 1
Subsection . . . . . . . . 1
The End 1
Section

This is bold text, this is emphasized text, this is normal text. If you're bored,
go to The End.

Subsection

This is verbatim text.

The End

My dad used to say:
Damn, Pandoc has not been invented yet!

but not it has.



4.18

hyperref 3]7] 2= URL % 98 Fx0] g3 =
<o dlE

Insert>Hyperlink(slo] & 3)

S o] 2AE that 2ol HAsHSL,

7h5 o0} PDE7} Bake A 7

PF5 A s

\usepackage[colorlinks,
urlcolor=blue,
filecolor=magenta,
linkcolor=darkred,
hyperfootnotes=false]{hyperref}

g o=

\urlstyle{same}

The \hypertarget{ctan}{CTAN} main site
is \url{https://www.ctan.org}, a.k.a
\href{https://www.ctan.org}{CTAN://}.

Listen to \href{run:midifile.mid}
{this MIDI file}.

Click \hyperlink{ctan}{here} to go
back to the top.

The CTAN main site is https://www.ctan.org, a.k.a CTAN://.

Listen to this MIDI file.
Click here to go back to the top.

T B3-S \hyperref 41¢l o] 5o

JEHoR \url BHS LS FBE A4ttt BT}

\urlstyle{same}

7]

4.19

FAES HEHUE %5 7 349] dof] EolAY comment 37X 7} A|-8-5F+= \comment,

%% PDF g tjoj u}e} z| o] 5]7(] oko 4 olr},
_]

hyperref T7] 2] A1 gloj®E A},
Insert>Comment(F4])

5172 2r} 35

\endcomment I} comment 73S &

rlo

o
[%
kel
2k
o

=)

This text % boring example
\begin{comment}

what a boring example
\end{comment}

is just an example.

This text is just an example.

2 FO{A URL F2E
o HAES 7

MLE-H, [l s

. G2k 2| o] offFIof M=
.

™
o
nio
it (U
%
ot
Ot
=%}
o

[g‘?y’]memoir/obhvonroﬂ)\‘l IHHo =2
<comment> A2 HSTICH
\commentson, \commentsoff HHOZ

0|2 EO|HLt &2& = ACh

4.18 INSERT>HYPERLINK(3}0|m{2!3)

27


https://www.ctan.org/pkg/hyperref
https://www.ctan.org
https://www.ctan.org
https://www.ctan.org/pkg/comment

(9=

) B pdfcomment_ XgIEX 2 K[ SHX[2t
PDF £ =0 ¥ LEA9 4 Z £0]7] YA = pdfcomment T A E 2AH o1z o0l o128t soul 2 TH7 ||

[ ols ‘_ * | £ 0| I§7| X7} &&sH7| 20
ek o] Mol Al i thg ot o] MBI, obeh PDF 343 ol o mjek, 0 soulbosB oI ESE7 HEN
U2 == UL pdfmarginpar2t= ZHHS
[icon=note,color={1 1 0}]{pdfcomment} Bj51x/5} glo L pdflatex2F ECt. _'t”o“

Hl=%t 7|52 2t todonotes & 4 THE
AULE.

This text is nothing special
\pdfmargincomment{yup,

— definitely.}, This text is nothing special, but it con-
but it contains a couple of
\pdfmarkupcomment{nice}%

{simple, more than nice} comments.

tains a couple of nice comments.

PDF ¢ 49| 749 PDF Rolol| uhe} 2| s}4] 9h 497} 98-8 Sobwat.

5 Format Y%

gditHo 2 FAo 7|2 )H é? 3= 73517] 9fsli M= \documentclass BE 2| A2
Hojsith A + e FHoRE 7| & 28 37](10, 11, 12pt), 2] (adpaper, a5paper,
b5paper, letterpaper, legalpaper, executivepaper), 8% (portrait, landscape) 22 Z 0|
sl

\documentclass[a5paper, landscape,12pt]{article}

ZE 3]0 tfste] 5.2.3H 0l o] AHA|5| A stzlch

5.1 Format[>Line Spacing(3} 7%)

setspace 37| A= <singlespace>, <onehalfspace>, <doublespace
2|3l \spacing{amount} B (7)) 22 Hdolo| & 74 = AL 43

\
riot
o
o
2
o
e
iu)
.

AF37]

°
=
o
~

memoir/oblivoir0l A= setspace &
HEZ ZESHX| QOtE (7(‘|:"X|'E CHEXIZ
Se) Ze ST E2 A’ £ Qi

[92}] \singlespacing, \doublespacing, \onehalfspacing2 30|11, <single- @IﬁEH\singlespacmgoﬂ 2y

space>, <doublespace>, <onehalfspace>= &730|t}h. J2Je] Y3t M 5= <spacing> \Singlespacing BEHO| 1 <spacing>
5 5 _ CHAl <Spacing > A ™ E[= A|0[C},

2 ...ingo & ZUA|Th #olct yo] gefo] a2 1 Brko] FRE ofoF Gubrt

LebdT

\begin{spacing}{2.5} These two lines

These two lines \\
are crazily spaced!

\end{spacing} are crazily spaced!
\begin{spacing}{1}
Much better, these lines\\ Much better, these lines
are spaced normally. are spaced normally.
\end{spacing}
(55758l st20] 2 A= CHH| 2 H7HA2 S|
N . . _ FH= 0| UL koTpX Al Q| Ti7| X S0
A Aol 24 | 2HA-g 22 dHste W \linespread{factor} 82 ZaA [1ingu1) g4 4g£é M= 13 B ol
= LilRs! S 25 10|t} 38 o] Zto] H A &Y Alo AT o]zl S HE3IL} oblivoird 2= 2
=oll =1 Hr}. factor?] 712352 10|t % o] gho] #A] fole] ZHA = ol Xt} E T KO 1 vtan] Tl 2
v sy 7h2 oEF 1.6 A =2 Zho] Hr}. xgstn Ch,
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yup, definitely.



simple, more than nice

https://www.ctan.org/pkg/setspace

5.2 Format[>Character(ZA 2%)

£49l 27 B £AL E 0] FASIYT. EE 275 vhE B

x2E4< = HE8=
QA E = ZE o] AR 37|+ documentclassol] F-o1H 712 37](10, 11 £+ 12pt)°fl uf2t
gt 1 63 et
22t &7 89 27 oA
\textnormal textnormal main document font
\textrm rmfamily roman
\textit itshape italics
\emph n/a emphasis
\textmd mdseries medium weight (default)
\textbf bfseries boldface
\textup upshape upright (default)
\textsl slshape slanted
\textsf sffamily sans serif
\textsc scshape SMALL CAPS
\texttt ttfamily typewriter
\underline underline  underline
\textsuperscript n/a this is superscript
\mathrm n/a X"+ y" # z2"Vn # 2
\mathbf n/a x" + y" # 2"Vn # 2
\mathsf n/a X"+ y" #£ 2"Vn #£ 2
\mathtt n/a X" 4+ y" £ z2"Vn #£ 2
\mathit n/a X'+ Yy £ 2"Vn#£ 2
\mathnormal n/a x4yt # 2"n F# 2
\mathcal n/a XN 4N #* ZNYN %2 (59 512 2 oM 0] =] & ZHx2
O Eoieh Zlvtof BOHE BE2 QiCh
F4: ZA S =m S| M= T2 22 AL
KM=z EHSt= Ag M@oh= Tt 0
CLH-HH HOlE0|| e Q= HO R QA 2
71891 A A (italics) 2} =4 (emphasized) 2] xto]of| th3l| 3 3lof gtct. th2 ol &S 7|§(|>_Ij gzs _"llotuj(F PEHE) "HS
B \empht Rio] B}2 4 A2 o] 98-S B 4 Utk o]sk 2ol \emphi AR oot do| izt e e
efol E 225} & A Hole WHol ohviet £ P2 bl g Rolok ¥ M Lo glou HR s e

Of{IHTL ZE EHES 24 AR
AR QICtT & 4 2Uck

\textit{For example, this

< portion of text is typeset For example, this portion of text is

< in italics, and \emph{these typeset in italics, and these words
— words} are emphasised in are emphasised in upright.
< upright}.

3, o} AHE 44 BEO|AEF AL§3HE Zlo] Uviolct BE el Ao ALg3te]

p=! L
=] * (o .
ot ok 22 Egle & 4 ok [ wlojafet E2lg £

\textsubscript HHS Edt0] Yt
- HAE0f| Of2iMXtE &g 2+ QAT
this is \textsuperscript® OFEHZEA]
$ {\mbox{\footnotesize% this is subscript
{subscript}}}$

shephe Ale 44 BEA Yeisto] ~ot 2 Y tel ol WAE A 4 9lrh. 1
2Lt mhchem 3712 2 o] 8314 | 2hestet. 2Abe vl ol H AR Soj7he] ~ HE

5.2 FORMAT[>CHARACTER(ZX 22 29


https://www.ctan.org/pkg/mhchem

ZE 37] oAl

tlny sample text
scriptsize sample text
footnotesize sample text
small sample text
normalsize sample text
large sample text
Large sample text
LARGE sample text
huge sample text
Huge sample text
E5 EE 37]

Default font size 10pt 11pt  12pt

tiny 5 6 6
scriptsize 7 8 8
footnotesize 8 9 10
small 9 10 10.95
normalsize 10 1095 12
large 12 12 144
Large 144 144  17.28
LARGE 17.2  17.28 20.74
huge 20.7 20.74 24.88
Huge 24.8 24.88 24.88

gl

cheol 9= 22 A AHTITE S AL \ce B AR Yt

\ce{H20 + C02 -> H2CO3}\\
\ce{CaC03 -> Ca™2+ + H,0 + CO;, — H,CO;3

= BN CaCO; — Ca® +CO5%"
\ce{C03"2- + H2C03 -> 2 ) )

< Hco3/\_}\\ CO3 + H2C03 —> 2HCO3
\ce{CaC03 + H2C03 -> Ca"2+ + CaCO; + H,CO3 — Ca? +2HCO;"~

— 2 HCO3"-}

H|s=5F 28 LA chemformula 3 7] A = Qlch.

S7)% 4] gh= Zlo] QukAolt, 0|2

o) A2 ol BAb| 2 28 29 A de) Aoz
A 27) A = gkt :LE:MEE%L m WEg WhEA] Tojof Shehel ulem 17] 45

=
= UE o] B /1A AL S A BFomx 171X Zol|A luatexko= X
o} ulemRF BH S MSSHCE XgTEXO|Lt

: pdflatexO[2tH ulemS B = 2EDHC,
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\uline{important}

izvuv;(z({eég;?}ent} important urgent boat wreng

\sout{wrong} oY ed

\xout{removed}

ulem E’H7]Z]% _2/\:] 0“0] E’._Eﬁ].l:l:] \emph EF]E:] o ZHX_]_‘IOI_O:] O] EH ‘_]_ E‘g% %7]51
HHEch o] A2 sl thg it Zo] A4S Hojsiet, 42 (542 ylem It QAR 7|52 HZSHH sou

17| X|= QLI EL SOFA|OF 2Xt2 &

\usepackage[normalem] {ulem} X155 Bot EAS S6] xolatex

lualatexOllAl= 0| & AFESHA| &*t‘:%
5.2.3 Format[>Character Size(Z 24})
BIEX o] B Alo] 22 Z R3] gt extsizes T 7| A7} =0 € Zolth, BE A S
AS 5to], 8-12X QN E | 14,17, 20XV E M-S 2712 Hojg 4 QA st
oAt 22 17pt article= 235t Shohal s B}, 12| oh5ak 2o A &betH
Hr.

\documentclass[17pt]{extarticle}

2 275 D= uE B2 typelem B7| A& o]-&sh= Zolth. g 22 FH O

L Fs)}. BF Cltypelem= 222 type1 CM2Z 2
Adsh= 70J0] 220 M 20|17t ALk
QIfiZQl QEEIY EES AF8%H= TX
\fontsize{72pt}{72pt}\selectfont AZIO A= O] TF|X| O] % Of| M| 7} K| A| Bt
No Smoking PO oot ZRE HE UL

(o] oAlA| 9] Atz o] EAoll EAst7 ol U 27| w2l A} oAl S ettt +=
QA 217 EE 2719 wo] 2ekel (34) ) Lololc.
k2 AP o2 ohg it o) sk £ 9ok (5544 ok )| 47K adjustbox Ol

\resizebox2} OFXH7IX| 2 gHA XK 2
2toistE HEO| HOl=[of UL 222 o2t

=

Ze g o= o yYe

\resizebox{!}{1lcm}{1l-cm tall} 1 _Cm tall \adjustbox{height=1cm}{1-cm
tall}OlCt.

1 ©HEE & 2AE FAI5hHE lettrine lettrine 7] X2 \lettrine Y& o|-&
U stk of2] 7k ARgAE) 7hs gt o] Bkoll A Kol A& thga) Zo] 7| Bzke
2 2 Zlo|H,

\lettrine{D}{ropped} capitals at .
< the DROPPED capitals at the start
start of a paragraph can be of a paragraph can be ob-
obtained using the lettrine

tained using the lettrine package,
— package,

5.2.4 Format[>Character Font(ZE

BEX 2 Qe 52490 ZE A|AHRS 7F20 9l 7|2 282 Computer Modern©] T},
METAFONT A EA| ARl 53 Z o g mjnjtt 238 ZES A5 o2 A4ttt o]F 7
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oz of FRoM e AT 2 S Bt FES 2HEAET 4 AT Y
$-2]:= &7, Times, Helvetica, Sans Serif 5 T2 F7F2] ZEo| 2% A Qlct.
thay 3], BIEX A7 PostscripT Type 13 2 ZEFQ] OTF ZES &85 4= ek

avant, anangar, bookman, chancery, chanter, courier, helvet, helvetic, ncntrsbk,

newcent, palatcm, palatino, pifont, times, utopia, zapfchans-°] Type 1 ZEE &

23 o] 2835 4 Q1= wj7) ] E0|t}. \usepackage{times} S Ze|YLEoj Zojgom

oG E=A] Zels Ha}. o] A= libertine T7] A & ©]-&-5F3i Tt

Chek, 4]S o2 wjoll= Computer Modern EE S #|-835}= Zlo] A ojgte Ao
FolslAl. ohe EEZ AMESI $8t4l0] W7} of HE AutE shA &t

FUIZER EFER, LEE] EES A Yot xelatex2 A2 2ot & 4= =
Uo] A Wolrt}. LaTeX Font Catalogue UAO| ES ¥-E3}0] o ZETL Ql=x]
gelsf w1t

ol A AFet 7| A S5 BA KA EES A5t Zo|t}. ofghe] gl AE gt
£ EEE A -&3te i o2 ofAloll Al Eol= 2| font family & A siE . &3]
2:0] = font family S E 70l 2 ks FAch. B font shape 7t L Eol| A& x| =] 7] g
& Itk AbA & dobEat,

This is Computer Modern Roman,
{\fontfamily{phv}\selectfont
this is Helvetica!}

[FAH oA AFeH HZ 99 clA| & XqBTEX o2 ZHutdshs H g 2ofA& AFHZ
2=t I Al ok |9k o] Stofof st} Latin Modern©]2t CMolA & 2 ZE}Q] :EL

L 2X Xg¥TEX 9] 7] ZE 0|4l TeX Gyre Heros= Helvetica®ll th-5-5H= TeX Gyre 2%
(2Ee))oltt. EE HJHE 9l fontspecs ZE3oF 5h=t] pdflatexZ ©] 7] 2=

L =1
A QehA| =

\fontspec%
{lmromanl0-regular.otf}%

This is Latin Modern

— Roman,

{\fontspec%
{texgyreheros-regular.otf}%
this is Heros!}

This is Latin Modern Roman, this
is Heros!

5.2.5 Format[>Character Colour(Z*} A4)

-

color = ]3]

xcolor 37| 2|2} Td B o & F2tof| Mg
white, red, green, blue, cyan, magenta, yellow 7} % 2] =] o] Q]

o] ol 4 Ick.

o

23H3 A A

2= 9it}, 7|2 A 0 & black,

SFelze my|xe faye HotYsts
QUEION I A| ZLEICE O] EHEf2 =2
pdflatexO| ZIH AIEIQN Aol MLt
Folojsict, HAEE xelatexS 01850
Aot st=g| o| mf o|2 mi7|X|= 2|a| 7t
AL FOfM ArZsHiOF BT}, T 1=
libertine I§7| X|:= pdflatext xelatexOll A{
DF FESHA SEfetct.

(57461 0| 2etof| A LSH= font family, font
shape S2 pdflatex AIZEI0| M M0|= EE
e A A”o] Bojolch, QLIBE ZES
st ATl A= 0] BH2tol L0
MEE|X| =0t H 7= OFEIEX|CH

[

AR * 47

5971 0) 2| Ho|=l MASAIS xeolor 7t
CHSHA MlS st A} H latexcolors,
ninecolors S M4 H2|E NS dt=

Ij7|X1S0| ULH.
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FE ue 9y

=
cmr Computer Modern Roman
cmss Computer Modern Sans Serif
cmtt Computer Modern Typewriter
pag Avantgarde
pbk Bookman
phv Helvetica
pnc New Century Schoolbook
ppl Palatino
ptm Times
pcr Courier

H 7: A 2ol= ZE mjU ] (pdflatex)

\textcolor{red}{This is red.}\\

\color{blue}

This text is blue!\\ This is red.

So is this. Let's change.\\ This text is blue!
\definecolor{mygreen}

{rgb}{0.1,1,0.1} So is this. Let’s change.
\color{mygreen}

This is my shade of green!\\ A cyan box

\color{black} -
\colorbox{cyan}{A cyan box}\\ ‘A green box in a blue frame ‘

\fcolorbox{blue}{green}
{A green box in a blue frame}

L}ol7}, \pagecolorghs o] e, ofH ATE 7H4 A sk W QA] Azke
AR

5.2.6 Format[>Character Outline(Z4 2A})

Skl g Asl= Ao 2 2] grrtH contourﬂﬂﬂxlg o] &35to] S (QEA)

7
27+5 BHEo] B2t \contour B2 A 16W (B Aot A4RtE) A4 &
‘LAl g THEol i S sk 20l = Bt HEE)

\contourlength{0.5pt}
\Large
\textcolor{blue}{\contour{red}

{Blue text, thin red outline}} Blue text, thinredoutline

\contourlength{2pt}

\textcolor{white} mmwmm
— {\contour[32]{blue}

{White text, thick blue

— outline}}

5.3 Format[>Paragraph(E% %)

BFela g0l Fx|ote ChEA|, ARHE \\ 2
. al B EAE o ol HE A 1 Hel MaLL Ao].o Apolay ZLtE 20l 2tro| ofLlate He
TS\ R 22 Zus g A AR 22X 1 Fell= BIEX O] 735k AYS 4715t axsize) sict 2o vl 2o/t \parz
2}, L= 242 YBITH \\ = CHX| Bt 2

Ljofl M2l ZHH) ZHHRo|Ct
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Ll | A

abstract QoFrr

array S8kl o) i

center 7hedl 8E

description ARd B AE

displaymath HY 29 (displayed) 4]

document A HAE e

enumerate Ho R 2 AE

equation Hey 2y (dlsplayed) £8H] (A SR

figure o= 18

flushleft AX A4

flushright =z Ay

itemize HSHFGAE

letter HA 4

list 7|1A g AE 27

math = (In-line) 44

minipage ]quHO]Z]

picture HAE Shabm ajd o 59 =Y

quotation o2l £ A& (A & 59927 UF)

quote dEF AET(AH E 50127] 2le)

tabbing B AamZ ol 42

table oY= &

tabular Yt 2 HHE HAE

thebibliography &% 5% Z]AE

theorem A, HA 5

titlepage A2 A4

verbatim AHS :LEHE Hol7|

verse Aot &8

8 EF KX &7
HIAE O] gdHo| EASH &4, o) FE FAoly ZE Y 52 Folot7] fls
217 (environment)< ©]-&3tt}. o] A2 nix] nfe AR HAE JRE HEsto

2HE B4 £4& AU HES SH5t= AT ARG S22 R HAE

\begin{environment}
..text goes here...
\end{environment}

o
Mo

ol & S0 KA},

o& 7hetl JE5H7| 2 5FH <center> 735 &35}

\begin{center}
this text is centered
\end{center}

this text is centered

Bl
Y
riot

Q=

A4S E 89

2.opstgich. o2} 1 AHg

e 2 7k 2ol
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5.3.1 Paragraph[>Horizontal Alignment(3¥)
7| EHoz Fohe FEEEFOoR FHh AF HHo|u 22F Y
JE L2 <flushleft>, <flushright>, <center> &7 ¢to] HIAES
7}
7}

\raggedrlght \raggedleft, \centering©°] o] &7} Z
£ USRI 2L o] AZst7] M7kA = 237 UERUHA] =t

5.3.2 Paragraph[>Vertical Alignment(Z% Alc]e] &)

S FRHE BEXe] 4ol 15 Z2AIN AGAS 0] Bt %7}% k. gl
Fo|L} o] of2] 7 ohiz oft}e] ¥l &, s}LpS] FE o2 ZHEFH. whetA Hl Fg of2
N AL siA] 25 Abo] 7} B ®of A= A o] ofy 2= Tolth. \smallskip, \medskip,
\bigskip©o]gh= B3 S 2ot Alo|of] HA|Z 02 & ofdojo} Brku} Rk Alo|o] A=
de 4 Uk
ol 2t} ¢ 7+4e a1 Ak \vskipS th3 2|9} Zo] Hojygom Hr}, 0 (%550 yskip 2 TX 0|1 \vspace's

BTEX B O|CH E\EE \vspaceS * &= Z0|
Ol X| gt ofl2E R[S 2= RULE \vskip

These paragraphs will be sepa- S oAlo et o] Zigizte T 5o =}
rated by 1.3 cm: \vspace= Z0|E ZYS 2 S2{MA
These paragraphs will be O|X} 2 FErstT},

separated by 1.3 cm:\\
\vskip 1.3cm
there is a 1.3 cm gap above me.

there is a 1.3 cm gap above me.

_L4

\vskipe Q27| ek Abolof MEE SARGTh, AZE Ho|x] o] Ao (5 o] o] Lk
o] ghi= Aol M) el Ak 1.5cm ) e £ 2Lk AlAsk ATk o} @A shof @7t
\NULLS (G 25 jAl) “EX)'2 Ao} 742 Mgsfof Sk,

\null
\vskip 1.3 cm
This text comes after 1.3 cm...
This text comes after 1.3 cm...

o2, \vfill 3o it £ 21 Ao|5 ¥l Lo Aot o AHgdT & &
W) 2ehe P4 1 w0l 2o vigto] @A fck. ohg ol & Fste),

This appears at the top of This appears at the top of the page...
the page{\ldots}

\vfill

{\ldots}and this at the

= oo, ...and this at the bottom.

5.3.3 Paragraph[>Margins(Z& )

25004 £ uh, Bgk Ze 24 o] A A g Zlolch, 3 AHou ek £ W
st 74% ‘:&1—1 2 5857 th @ Brko] gUEg WER Agstel Grinl the
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\newenvironment{margins}[2]

{
\begin{list}{} {

\setlength{\leftmargin}{#1}
\setlength{\rightmargin}{#2}

} \item }
{\end{list}}

o 2ol HelFt §4S ket 2ol AHEITE !

As you can see, this paragraph

has normal margins.
\begin{margins}{0.5cm}{1lcm}
But please note that this

paragraph has custom margins.

\end{margins}

As you can see, this paragraph has
normal margins.
But please note that this
paragraph has custom

margins.

5.3.4 Paragraph[>Indentation(E°27])

L
.

Z 5oj27)o] 27]5 A5t \parindentgl= Zo] H4
E927]E lemZ Sk 2ot

\setlength{\parindent}{lcm}

\indentﬁl} \noindent H&< 1 t}So Q=
92 \parskip Zo| mjetu|g| 2 Rt Alo]o] 717

209 5

\setlength{\parskip}{3pt}

5.3.5 Paragraph[>Border and Shade(Z&| 93} 39)

=1
L

S} framed T7] A& 20t = \parbox ¥

Frho|i} thojof] ma Y-S =]
85} 5=t o] W= calc o)7] A7} D @ 5}c}. >3
47 framed & o] -&5}= o] £ Ho|z},

F=

o
[

\setlength{\FrameRule}{2pt}
\setlength{\FrameSep}{5pt}
\begin{framed}

this is a framed paragraph!

\end{framed}

\definecolor{shadecolor}{rgb}

{6.9,0.8,1}
\begin{shaded}

this is a shaded paragraph,

do you like it?
\end{shaded}

this is a framed paragraph!

this is a shaded paragraph, do you

like it?

He

EF U0 oMo e MES BHS
Holsto] A1 =0, memoirOl
<adjustwidth>2H= &40 0| 7|53t H9|
FAtet A S MBS TiC) memOIrO\ A
changepage T 7| X| (T 0| 5
chngpage) 2| 22t SYSiCE.

(5552 g2 S =E =
=AM K 2 Ato]of

kJ

Ae [[HD;I-_);-|\|_§
7"Ol ofL|2h= o ==
2] S parsk|p
20| ELt.

= [ 10 rot
M
[ d
rr

%53 hemoir/oblivoirOfl A= framed

7| X2 2 J7|5S KA FE St UL,
SHH I Q%I Bl AE 180 QU0 A=

2rot IH7|X| 2 adjustbox, efbox 2/0f|
tcolorbox S BtEA| AAg 8 =2 $tCt. Of
HHEL I | XK= HA[SH A S T2|=
=Hof AoIM BRot He tiRE2 7158
M| Z etk
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12|31 boxedminipage 37|27} QlHl, &2 o529 &4 & 4 A k. 25
JES FAH oh T 22 YRS Wel= A2 AMA <boxedminipage> 732 2= AT
sttt

\framebox{

\begin{minipage}[c]{\linewidth}
text to be framed
\end{minipage}

}

\width oj32. 2
oI}, 22 Yatr

Fof 7l Ao

this is a

\framebox[\width]{framed} this is a word

word

A9l4kS 45k a9 Z& vtE 4= Ut

this is another . .

\framebox[2\width] [r]{framed} this is another
word word

T WA g4 Ak mo

il o tef i gol =
LEZ(r) FHoIH.

wo] g2 A & 2|t o] BlolAj s

A1)

HoU olA] A= AAst Ak, oA sk,

5.3.6 Paragraph[>Colour(2%

2ol mailg)

olo
o=

\colorbox{yellow}{
\begin{minipage}
{0.8\linewidth}

I am a minipage, my I am a minipage, my colour is yel-

— colour low!
is yellow!
\end{minipage}
}
oA Alefl A E=o] minipage 2t 1 M2 3 1H] 9] 80% T A 8= =& ATt

Aol Thsto] o AHAISE AFEHE 5,258 S Fastat

5.3.7 Format[>Columns(thdh)

\twocolumn®} \onecolumn HHP -2 2L Ho|A =
\documentclass? A o2 A QT 4 9}‘4. ojAo g FEA|
7] X7} A &5k <multicols> 73 0] Sltt. o] & o] 83slo] o] Ao] W8-2 o] E’P_E 2

shaA Yokwl the A st Zole. >

%_ggnHam 0|52 multicols2t1
AA2 HOICH SHI2AH| Sxp7+

2SI CE multicol 2| HE S HtEA|
MZ2 H|O|X|E Al &SHK| gfo fE ElChk=
Aot nttEAES IOt o~ QICh= FO|Ct,
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\columnseprule=1pt
\begin{multicols}{2}[\subsection{\entry{Format}{Columns}}]
The commands \cmd{twocolumn} ...

\end{multicols}

o Abo] 9] 7HA-2 \columnsep Z o] M4 A|ofstth \columnseprule tiaZ &
Atololl oAl Ao #7]15 vebdich > tiZ S 2 52 4 At el AEE= ohgk 31
AZFet7) Ao e gH o] @S A Y& bl R 2ol

6 Table W&

A& (2d7E) ol 24 AL St o] Fgk A ol 7] EAL.
o]n] %] (image)?} figure@H= T Azt w7 2, <tabular> 3HE3+ H (table) = A
T2} BIEX 9 tableo]g 212 HTbU = 704 (4.14F 0l A AW) 24 3t H[o] 2] & ol

s
2o
=

2
7}

A gk Zolojok gttt S E 4 AL A= <tabular> #73& 1 Qroll ZFFT}

<tabular>+= E83t FH o2 U&sfof sl=t| o] F Agszlct.

7] BIEX tabular 7§l T332} Zho] A o) gict,

\begin{tabular}{|l|c r|}
Z, 39, 92 ¥4
s 22 3, NEZ=

s M2&2 BE O|4L0[A ottt

o°
172}

\hline 1 2 3
1&26&3\\ % &9 & a c
\hline % o M

a8 GC\\ % SHA HA u one | two three

one & two & three \
\hline
\end{tabular}

~

oA7IA A, A8, A- e 5 AAT A2 = 4 A tabular?

25 S o] 2ojHitt.

e

Y2 gol ofatof

booktabs T 7| A & o] &5}H M2F0| gl o MEE BYS Z-= tabulars 18 £

At

\begin{tabular}{lcr}
\toprule
1&26&3\\ 1 2 3
\midrule
a& &c\\ a ¢
one & two & three \\ one two three
\bottomrule
\end{tabular}

ohgoll Eol= A ollAl= tabular 74 & Zoid 5= -2 A et

38

TABLE 0| =


https://www.ctan.org/pkg/booktabs

% 48 H; AB/IY/REZ FH; 1¥YE
\begin{tabular}{lc|rp{4cm}|}

\hline % TZHid

\textbf{Left} & \textbf{Centre} & \textbf{Right} &

\textbf{4 cm}\\ \hline

row 1, col 1 & row 1, col 2 & row 1, col 3 & row 1, col 4\\
\cline{1-2} % 1-2 A0 MM

row 2, col 1 & row 2, col 2 & row 2, col 3 & row 2, col 4\\
\cline{1-2}

\multicolumn{2}{|c|}{spanning two columns} & row 3, col 3 &
row 3, col 4\\

\cline{1-3}

row 4, col 1 & row 4, col 2 & row 4, col 3 & ~ \hfill right\\
% ~0f o|3t ZHZHH

row 5, col 1 & row 5, col 2 & row 5, col 3 & left \hfill ~\\
row 5, col 1 & row 5, col 2 & row 5, col 3 &

~ \hfill centre \hfill ~\\

\hline

\end{tabular}

Left Centre Right 4cm

row1l,coll rowl,col2 | rowl,col3 rowl,col4

row2,coll row2,col2 | row2,col3 row 2, col4

spanning two columns row 3,col3 row 3, col 4

row 4,coll row4,col2 | row 4, col 3 right

row5,coll row5,col2 | row5,col3 left

row 5,coll row5,col2 | row 5, col 3 centre

tabularray

o] 282 Jr}r} 271etth, EH (tabular) & 22159t KX AHEALE 1 &35 2 2AIA
Choket 2719} 770l th sk 24, 37]4 So| Lhe.0 2 thrite] @ 727k @bt
Al = glout |7 g2 s 2% w2l 28] 7o) oy =] &7] o2& dEi7t = i
tabularray = TE S 18]& o) Zestn 28491 mj7]x|o]c}. o] QFA S Z3}slo]
= 5o] chste] ARak BAIOIA A7I5He A2) TR 715 key=value £ o]§
sto] FEE 4 ek, Yrhet hir ol sk A 2 4 e Aol
9ol A A1E BE tabularray 2] <iblr>2 2] o] & Bo|Zth,

\begin{tblr}{
colspec={Q[l]Q[clQ[r]Q[4cm, 1]},
hline{1,Z}={.8pt}, hline{2}={.6pt},
vline{3}={.4pt},
vline{3}={4}{dashed}
}
\SetRow{font=\bfseries, fg=olive5} Left & Center & Right & 4cm \\
row 1, col 1 & row 1, col 2 & row 1, col 3 & row 1, col 4\\
— \cline{l1-2}
row 2, col 1 & row 2, col 2 & row 2, col 3 & row 2, col 4\\

TABLE 0|+ 39



\cline[dashed]{1-2}\rline[dashed] {4}

\SetCell[c=2]{bg=gray!30,c} spanning two columns & row 3, col 3 &
— row 3, col 4\\ \cline[dashed]{1-2}\cline{3}

row 4, col 1 & row 4, col 2 & row 4, col 3 & \SetCell{r} right\\
row 5, col 1 & row 5, col 2 & row 5, col 3 & left \\

row 5, col 1 & row 5, col 2 & row 5, col 3 & \SetCell{c} centre\\
\end{tblr}

Left Center Right 4cm

rowl,coll rowl,col2 | rowl,col3 row1,col4

row 2,coll  row2,col2 | row2,col3 row 2, col4

row 3, col 4

1]
i
5
E,
5
(5]
-+
£
S
o
2
=
=
5
172)

row4,coll row4,col2 | row4,col3 right
row 5,coll  row5,col2 | row5,col3 left

row 5,coll row5,col2 | row 5, col 3 centre

tabular7} U Z oA} §F of|o] #] Qtof] S0{7}A] ¢= w7} Qltt. longtable #7125
o]-&sto] of 2] m|o| X|o]] A x| tabularE AH/d5h= o] gt 74A] {WRio|tt. gHH rotating
7| A= <sideways>et= 732 A|-5-5t=tl| 0|5 ©]-85'H tabular A A (= cell 5t
ENEE 7Y Foi7 ZtentE 3 HAZ 4= St

tabularx ™7]| A= EO] UH| & 1 Z0 &2 AT 4 1 X ZY A|A|AHE 0]-&-5tof

A S WA Zol| tisto] FHhi2| <l Aol = Ws| A 58 4 A St

Th3-2 of|Alo]Th.

\begin{sideways}

\begin{tabularx}{7.5cm}{|1|X] o
a=!

— X[} H 5

\hline ] £

\textbf{normal} & 2 —~

— \textbf{tilted} &

\textbf{wider}\\

\hline

normal & \rotatebox{30}% 55(9

{I'm tilted!} & 2 %

I'm wider\\ = <

\hline s~

\end{tabularx} = _

\end{sideways} E g
=

g 8

T8l = longtable, supertabular, xtab 22 83t 172 S0] c}.
B QoA M-S 22 H colortbl 17| ] & o] &t}
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Colour by row:\\\vskip 2mm

\begin{tabular}{lcr} Colour by row:
\rowcolor{cyan}
one & two & three\\
\rowcolor{green} one two three
one & two & three\\ _
\rowcolor{yellow}
one & two & three\\ one two three
\end{tabular}

Colour by column:\\\vskip 2mm

\begin{tabular}
{>{\columncolor{cyan}}1 Colour by column:
>{\color{red}
\columncolor{green}}c
>{\columncolor{yellow}}r}
one & two & three\\ one three
one & two & three\\ one three
one & two & three\\

\end{tabular}

one three

6.1 Table[>Line Spacing(&2] 3§ 7+4)

r°l'

elol o] 9 7+2)2 BlAE ] olof wo|A AL, § Fo| AZre}r] Hof 274 <
AL 8 FHhH 7HE (length) 7} 0pto] I L3 0] (height) & 2H= Ho|z] b= A
\rule 12)= E2o] Qith. 3 0]Fo) HAL Falw \\ofl g4 A= ol S A A3tk

ohg o2 ® .

\begin{tabular}{1l11}

one & two & three\\

0.3 centimeters & one two three

< \textbf{after} & 0.3 centimeters after this line
this line\\[0.3cm]

one & two & three\\ one two three

one & two & three\\ one two three

\rule{Opt}{1l.2cm}1.2

— centimeters &
\textbf{before} & this
— line\\

\end{tabular}

1.2 centimeters before this line

6.2 Table[>Aligning Numbers($x] J3)

I

tabular & 1w} S8G F92A 23] 2o A5 XS 71202 LsHor T
oIt

Vg e e @ 2Y ANRE ol g ok Zolth SRS Teehn gl ol
A 2 Wik, Ay Relxt &7t 250 2 HhHT

6.1 TABLEI>LINE SPACING(HE 2| & 7HA)
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\begin{tabular}{r@{.}1}
3&14159\\
1861803\ \
1841421\\
100800000
\end{tabular}

3.14159
1.61803
1.41421
100.00000

$HH | dcolumn T 7] A
b= Al 7He] RIS ZH=

(B2 = E} OIEH

mm

‘1)}1]:“

14 rlo mx
B e

o op

o
)
o
|
—
o
rg
i
ol
1o
_>‘~_‘ Flﬂ é; l‘)‘ o

0

ul

4

A

o

2% A AR

1 ol &7 154 ¢¢@ 2202 et 247

2712 2 4 QA =), o] XA

oltt, Al A QA A (dot)
A
1 AR e,

\begin{tabular}{D{.}{,}{4.2}%
D{.}{.}{53D{.}{.}{-1}}

\toprule

\mbox{One} & \mbox{Two} &

\mbox{Three}\\

10.33 & 10.33 & 10.33\\

1000 & 1000 & 1000\\

5.1 & 5.1 & 5.1\\

3.14 & 3.14159 & 3.14159\\

\bottomrule

\end{tabular}

One
10,33
1000
5,1
3,14

Two
10.33
1000
5.1
3.14159

Three
10.33
1000
5.1
3.14159

6.3 diagbox(e] tjztd)

diagbox T7]x]= \diagbox §#¥& A3t}

\begin{tabular}{|l|1|1]|}
\toprule
\diagbox{Lesson}{Date}

- &
Monday & Tuesday\\
\midrule

Date
Lesson

Monday | Tuesday

Stratigraphy & room A
— & room A\\
Chemistry & room B &
— Lab $\alpha$\\
Physics & room C & Lab

Stratigraphy
Chemistry
Physics

room A
Lab o
Lab é

room A
room B

room C

—  $\deltas$\\
\bottomrule
\end{tabular}

(5%57] of| & 0f| slashbox IH7 | X| 2 EHAd st
2ALY T2 E 2|50 diagbox I 7| X|=
slashbox 2| & 74X FFof| CHet XS 5t
ULt 3222 L%l slashboxE Aot
oot gich
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6.4 BIEX E A7)

£2]5] Dol Al tabular 2] W& st 2= 22 AZS dolot. ohdls| A o=
THE tabular W8-S BIEX ZE2 A5+ Ao EVL Q).

Sin’

« https://www.tablesgenerator.com/
o https://www.latex-tables.com/
« https://tableconvert.com/latex-generator

o https://products.aspose.app/tex/latex-table-generator

6.5 KIEX H°|EE t°o]¥] 7}x 27

98] RrojA dole w2 A/ YFE ke ol & Z st} dolE st tiRE
AR AL A S FE5 T ASCIL I wi = QAT
st} 7o) thiEo] AT EAE T2 ASCII H|o]A9] ,csv Y THio 2 YjB
W75k o] 7}—0Ptﬂ, 4% FEAE TR 3He Zlo] Foh

clel e 521 8- X

Az EAE GA o] 7| E

e

sl 12312 H0|220] ok TAB
XLt 7|EF 2XHE ME BX|0H (Csvats
= 0S¢l 2lojeks g2l) #E ()= Jotx]
o]lo] A& Ao ubx HESIX| o=, 1 0|R= 2t o| Alof|
<l ol Bl ST} S0t HAE T ERE & Q17|

o M
rlo
N
i
o
)
o
i
9
£

Mo

#!/bin/sh
# dat2tex.sh: converts tabular data to a tabular environment
if [ $# != 1 ]; then

echo "Usage: $0 <datafile>"

exit 1

fi

# is this a csv file?

grep ";" $1 > /dev/null
if [ $?2 = 0 ]; then
AWK="awk -F;"
else
AWK=awk
fi

# ok awk, make my day
$AWK '{if (1 == FNR) { \
printf "\\begin{tabular}{"; \
for (1 = 1; i <= NF; i++) {printf "1"}; \
printf "}\n"
)
for (i =1; i < NF; i++) \
{printf $i" & "} printf $NF"\\\\ \n"} \
END {printf "\\end{tabular}\n"}' $1

# end of dat2tex
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7 Tools Hl%

7.1 Tools[>Mail Merges(H ¥ 7))

o] 88513 A7 HoFslA| sl 7152 textmerg 7] x| o] FHAE o] Y} EA
8o EAol| A o] 23} 4, YL upioj R 7heket A2 AYzte| Rl 1 o]9|o]
g2 st

B Aol A Pekx| L BB sl Al /9] HE (feld)S A 2|8 Zlolch. Zkzk \Name,
\Surname, \Titleo]2}1l 3}#}. o]o] sfddl= 7k e)& utAd?l data.dat ZFE] 714
er},

\documentclass{article}
\usepackage{textmerg}
\begin{document}

% let's declare the variable fields:
% \Void is for empty lines
\Fields{\Name\Surname\Title-\Void}
\Merge{data.dat}{%

Dear \Title{} \Surname,\\

may I call you \Name?\\

Yours,\\
\hspace{3cm}Guido\clearpage}
\end{document}

u Ha =9l \Voide AA| Q3 A2 ol gt dA|E ¢J5to] £ich 1 o
apoA 7] S7F 2o Jlet o] A2 dlolg oA Hlof gl 4 A& YErdTt 7t
HREe] 22 ¥l Z& it
data.dat ot o] W82 o]H 4]0 & &|of 9]}

Guido
Gonzato
Dr.

Francesco
Mulargia
Prof.

Marie
Curie
Mme

7.2 Tools[>Labels(2}2 ZA)

Hd W27} Lok 2 S| = o 7hdsich 3x8 A8 A 2hE 84 Q]of] 53 ek 20
NE grEtha B}, ARSE w 7] 2], I &SHAITE [abelsghe Zlolth, Th2 of| Alofl A
1070 1 k2 1070+ g 5
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\documentclass[adpaper,12pt]{article}

\usepackage{labels}
\LabelCols=3 % n. of columns of labels
\LabelRows=8 % n. of rows of labels

\LeftBorder=8mm % borders of each label

\RightBorder=8mm

\TopBorder=5mm

\BottomBorder=5mm

\LabelGridtrue % show the grid

\numberoflabels=10 % number of labels of each type to print

% the text of the label is specified by

% the \addresslabel[]{} macro:

\begin{document}
\addresslabel[\large] % optional arguments
{\textbf{Guido Gonzato}, Ph.D.\\
\textsl{GNU/Linux Sysadmin}}
% now on to the boxed labels
\boxedaddresslabel[\fboxsep=4mm\fboxrule=1mm]
{\textbf{Guido Gonzato}, Ph.D.\\
\textsl{GNU/Linux Sysadmin}}

\end{document}

ehgo] N2 THe F48 TGS LA steln o)io] 242 HojE 2R 7
(]

\documentclass[adpaper,12pt]{article}
\usepackage{labels}
\LabelCols=3
\LabelRows=8
\LeftBorder=3mm
\RightBorder=3mm
\TopBorder=8mm
\BottomBorder=8mm
\LabelGridtrue
\begin{document}
% use either this environment:
\begin{labels}

1$~{st}$ name

1$~{st}$ address

1$~{st}$ city, state, zipcode

2$7{nd}$ name
2$"~{nd}$ address
2$~{nd}$ city, state, zipcode

3$7{rd}$ name
3$”{rd}$ address
3$7~{rd}$ city, state, zipcode
\end{labels}
% or an external file containing exactly the same text:
% \labelfile{addresses.dat}
\end{document}

7.2 TOOLS[>LABELS(2H& =t4)



textmerg®} labels & 235t &-85l= AT A =sl|E 7] v},

7.3 Tools[>Default Language(t}=°])

BIEX 2] 7|2 doj= dojoltt. 2|y thE doj = 2|3ttt of 7]A] ddof 2| olzt 3t
‘chapter’ Ut ‘index’2t 22 01 & Z=rolofl 87| AAshe= A, S8k sholZulo] A #4,
a8 gy et A FAES VI HRERRE(BE2 \c cH Vet Zo] Y= A
JGdr= A5 9ngih

KIpX v 22 holl = language . dat 2= 2+ o] ($TEXMF/tex/generic/config/language.

~

dat) Z3tE]o] Ql=d of 7ol 7t /lof E-2o] 9lt}, o] uhdg W5t} %Y ALEA/F Qs F o) mpalg Abg XLt HESH OF BTk,

oy o 0| 2A0] Cf| O|Ef I} 2 TeX Live 7t M St=

Stol = 722 7k Qlolg Mg 4 Stk 20192 1 Aleh 0 SX|%10fof i)
Qo] AH&AF7E ob 2t babel 7| A& o3 of| ek o] A&t ATAPHO| TH S HES 4 QUCH= 2N

H= =]
B 2 0N °“‘ﬂ¥9 g gonzf APEXF
SO0l 2101 HEL2 babel OfLt 210
\usepackage[italian,english]{babel} I§7|X| £ 0|85t A0t

I=5°  babel2 ¢ EAE 45t Aojof] AgstA viit= 4971 et Thef 2217}
Qite Bgo 2 yettA] =t \charxx WAl o2 sl B 2},

EIETEL A IR RUFTE Z2HE 221 o 7 UTF-8 & ol sliot =% sfjof
g g7t 9l 18]l 2018 o] Holl= inputenc®t fontenc T 7] X7} H 2 34,

\usepackage[utf8]{inputenc}
\usepackage[T1]{fontenc}

2018'd °| %, BIEX ) 7] & &2} 91292 UTF-8°| H{ct.

HEL D

o] 2 A7t F71et. ol E 2R A= BAE AAShe WY EEL2 koTpX
7] Z] (&) & ©]-85t= ZAolt}. pdflatex, xelatex, lualatex Z Q1zlof| thsto] 3t= 229
L& AFsta 2 FA = FjI

\usepackage{kotex}

koTgX $lol = g2 EAIsh= 22 2417k fleh. ohFet dlzlof] oiste] ohafst 1 o]
7ek=lof Qltt. o] & E9 pdflatexo419] cjk-ko, xelatex°ll 412 polyglossia 5] %12 Ujl
E73] lualatex 3}l A babel 7| #| 2] A} 7FeAd & =ob4] 7kal Qi

7.4 Tools>Hyphenation(s}c]Zy|o] )

A 2 BIEX o] Tol Q] sto] muj|o] & 2 X 2] dh= Hol 2
Shz Zlol B d 4 ot 2] sho] &2 fJsiA] At
o] U2 P 0 2 o] & 2]& thg1} Zo] s = A= 7Hssitt.

\hyphenation{ge-o-phy-sics ge-o-lo-gy earth}
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o) o] 5ol & 7+ Aol o AJoi] ©J5HR ‘earth’2h= Trol = o] Clo A sFo] & X254
247 it} o] gfol] £ Thoi7} sto] = 2] |x] 947 5t2lwl L ol S \mbox Sl =Tt

Do not hyphen \mbox{internationalisation}, please. I'm a
— masochistic man.

7.5 Tools>Spell Check(Z=} A}

ETEX AbAl & E Aol sl &) 2ottt Hx} HAFS 218 A & ispell, aspell 22 2|7 =0
oJafjof e, @ Unix Al2|IOA ispell S Thg-at Zho] AE-3F 4= Ql},

shell> ispell -t mydocument.tex

-t 29131 ispellol A TX 2 BIX 52 FAIstek 1 235H Aok, wrek ol }
ohUjehe -d 912 % A% Qlo] ARS Xl Fofo

W
e
o

shell> ispell -d italiano -t mydocument.tex

8 Help "+

2RQ1f @ mekol S 9hESh BIEX B E2 A+ B2 Wiio] k. do WhEsl Hotof
St 22 CTAN Afo]Eo|t}h. https://www.ctan.org/tex-archive/info/.
« Unix A& R 3ol A info latex HE= Hel™ BIEX HE 2 7Hdol tisto]
S| F 25 A S AR
« https://www.ctan.org/tex-archive/info/LatexHelpBook/ EIEXol thst
¢ 55 =&Z 2 A Windowsol it -8 = 2 = of gt

re,

« https://groups.google.com/group/comp.text.tex/topics #A&15S
FoHA & 4 Qi 2% £8S 9 4 Ae 7HIAE Aol

o] #AZ WA, tf R E o] GNU/Linux B Z 3ol Al x| 4= Qli= g Tx/

ETEX Al AR TeX Liveoll 01 Qlek. Zytol] 282 #4E& Al&3th. 142] Ubuntu

71419 /usr/share/doc/texlive-doc/ T2 E]g] olgjo| A EAE 23 4 Ut o
Liol7h, texdoc 2 B45] -85ttt ol S0, fancyvrb 7|2 A5 I th=&

We Y.
shell> texdoc fancyvrb

9 nix|=¢

o] 4= ® Guido Gonzato©l] 2J5}o] Zlu|d| ZE 2 A|&5HH GNU A5 &A] glo] AR
HjZ 3t} o] 7to] =7t = 2-0] B 7| & Hight}, of Aty IR E st Zxloj| Al HuUjEth
H oj-¢ 7]& Zio|tt,

7.5 TOOLS[>SPELL CHECK(EX} ZA})
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22 A BN WS

article 222 9] |IE2 2. 180 Bt} ol o B2 A& HF

L=

s},

\documentclass[twoside, 11pt]{book}
\begin{document}

\frontmatter

\begin{titlepage}

\title{The Book of Mine}
\end{titlepage}

\author{John B. Smith}
\maketitle

\tableofcontents

\mainmatter

\part{The Beginning}
\chapter{Introduction}
\section{Let's Start}

The book starts here.

\part{The End}

\backmatter

Thank you for reading this book.
\end{document}

1% A.1: Book template

\documentclass[twoside,12pt]{report}
% tables and figures at the end:
\usepackage{endfloat}
\begin{document}

\title{Final Report}
\author{John B. Smith}
\date{London, \today}
\maketitle

\begin{abstract}

This is the final report.
\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\part{Start}

\chapter{Begin}
\section{Introduction}

The report starts here.
\end{document}

1% A.2: Report template

48

\documentclass[12pt]{letter}
\begin{document}

\address{My address}
\signature{Guido}




\begin{letter}{John's address}
\opening{Dear John,}

Thank you for being my friend.
\closing{Hope to see you soon,}
\ps{P.S. Say hello to granny!}
\encl{My son's photographs!}
\end{letter}

\end{document}

17 A.3: Letter template

\documentclass[adpaper]{article}

\usepackage{typelcm}

\usepackage{times}

\usepackage{color}

\usepackage{rotating}

\pagestyle{empty}

\begin{document}

\begin{sidewaysfigure}
\fontsize{2.5cm}{2.5cm}\selectfont
\centerline{\textcolor{blue}{\textbf{Please:}}}
\vskip 1lcm
\fontsize{4cm}{3cm}\selectfont
\centerline{\textcolor{red}{D0O NOT}}
\centerline{\textcolor{red}{SMOKE}}
\centerline{\textcolor{red}{HERE!'}}

\vskip 1lcm
\fontsize{2cm}{2cm}\selectfont
\centerline{\textcolor{magenta}{If you do,}}
\centerline{\textcolor{magenta}{you'll be \emph{deboned!}}}
\end{sidewaysfigure}
\end{document}

13 A.4: How to write a notice

\documentclass{article}

\usepackage[absolute, showboxes]{textpos}
\usepackage{color}

\usepackage{framed}

\usepackage{graphicx}
\setlength{\TPHorizModule}{10mm} % standard unit of length
\setlength{\TPVertModule}{\TPHorizModule}
\setlength{\TPboxrulesize}{1lpt} % box line width
% start everything near the top-left corner
\textblockorigin{®mm}{Omm}

\thispagestyle{empty} % no page number

\begin{document}
\setlength{\parindent}{Opt}
\definecolor{shadecolor}{rgb}{0.9,1,1}
\begin{textblock}{5}(0,0)
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% this block is 5 modules wide; height is
% automatically determined
\begin{center}
\begin{minipage}[c]{0.8 \linewidth}
\begin{shaded}
This block is placed with its top left corner at the “origin'
on the page, which has been set to (Omm,0mm). The internal
margin and the shading are provided by the \texttt{minipage}
and \texttt{shaded} environments.
\end{shaded}
\end{minipage}
\end{center}
\end{textblock}
\begin{textblock}{6}(10,1)
\includegraphics[width=6cm,angle=-90]{gnuplot.pdf}
This picture is at (10,1). Note that rotating it
by -90 makes it overflow the margin.
\end{textblock}
\begin{textblock}{5}[0.5,0.5]1(2.5,8)
This block is at position (2.5,8), but because the optional
argument [0.5,0.5] has been given, it is the centre of the block
which is located at that point, rather than the top-left corner.
\end{textblock}
\begin{textblock}{3,4}(6,4)
The dimensions of this block are 3$\times$4 cm.
Its origin is position (6,4) on the page. Note that the text
overflows the margin in some cases; you'll want to
use the \texttt{minipage} environment to prevent that.
\end{textblock}
\end{document}

17 A.5: How to write a poster

B2P 32 Markdown¥} Pandoc °i|A|

(o] B A7} Z715F L)) 2.4 A 271513 1= Pandoc HEH7| £ 0]-8&3}= Mark-

down oA & =& 2Hdst= HES AlEtth. sig 2o HE

ilo
go
()
»
o
In)

title: |
=S 7|0 H=Cf: \
HEE & & 0|4 AE W
author: Guido Gonzato
date: 20184 1g¥
documentclass: oblivoir
papersize: b5paper
fontsize: 1lpt
classoption: gremph
numbersections: true
header-includes: |
\usepackage{fapapersize}
\usefapapersize{*,*,30mm,50mm,25mm, *}
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\ifLuaOrXeTeX
\setkomainfont(Noto Serif CJK KR) (* Bold) (Noto Sans CJK KR Light)
\fi
abstract: |
29%FS 07|0 Hoj&2}.

<t--- BUEL o YYo= HojEg -->

# MM o
A4S ~EE MY & Uk
*7|2¢ (italic)* X2l 753 20| of

Al fst=5 2YsloF stot. O7|M= LHHE

HYSHYUCH. Yot HAEE 1Y 32 MY

(o]
q0 9T HOB [DINY M) (#theend) O
#H# MEMA 5|
‘verbatim text'E MEES £ QLC}.
# OrA|9F MM {#theend}
OFH RN ZESHAIZ|E:
> 0|2, pandocO| Of2] HHE|Z| QLULCtL|!
2|0k 2Z€2 pandocO| UZA|.

<!l--- end of pandoc_ template ko.md -->

EA S AE oblivoirZ 3HtH HEL article =A17F ¥t} header-includes
H-2olA oblivoirg 913t A7 o] Eof o B & thE #A] SejAed o] 25 sl S
20| e & L5k A A < ghet

Pandoc S Z pdf ¥Zste]H of& B & W=,

shell> pandoc --toc --pdf-engine=xelatex \

pandoc_template ko.md -o pandoc_ template ko.pdf

--pdf-engines xelatex 22 A HsF3lT}. o] AL X]7} §lo™ pdflatex 2= FHutd
s},

YAML header2] numbersections: += Ao HS & Ho|gl= Zlolth HH3Y A
OF --number-sections AAE Fol& 2 AiE A=t} Pandoc? 7|23 AlM

M2 E Alsh= Aol
gkeF TOC7} B 2 51thH Pandoc A3 & LR - -tocstH &5t
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